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LANCOM Management Cloud 1.00.169.0 / 16.04.2024

- Customized device overview using savable table views
LANCOM Management Cloud 1.00.168.0 / 26.03.2024

- More comfort with multi-language support for the cloud-managed hotspot
LANCOM Management Cloud 1.00.167.0 / 05.03.2024

- Precise troubleshooting with direct links to the source of the error
LANCOM Management Cloud 1.00.166.0 / 13.02.2024

- Easy-to-view site assignment of a network

LANCOM Management Cloud 1.00.165.0 / 23.01.2024

- Central administrator management at organization level
LANCOM Management Cloud 1.00.164.0 / 02.01.2024

- A'look back at 2023

LANCOM Management Cloud 1.00.163.0 / 12.12.2023

-> Your direct access to cloud-managed VPN

LANCOM Management Cloud 1.00.162.0 / 22.11.2023

- LANCOM Trusted Access — Cloud-managed secure network access
LANCOM Management Cloud 1.00.161.0 / 31.10.2023

- Refresh of the LANCOM Management Cloud user interface
LANCOM Management Cloud 1.00.160.0 / 13.10.2023

- Simplified management and more overview for switch stacks
LANCOM Management Cloud 1.00.158.0 / 29.08.2023

- Centralized port templates for optimized switch rollout
LANCOM Management Cloud 1.00.157.0 / 09.08.2023

- Inspiration for your projects: Discover the new LMC website
LANCOM Management Cloud 1.00.156.0 / 18.07.2023

- Network extension & device setups within minutes

LANCOM Management Cloud 1.00.155.0 / 27.06.2023

- Efficient, automated workflows with webhooks

LANCOM Management Cloud 1.00.154.0 / 07.06.2023

LANCOM Management Cloud 1.00.153.0 / 17.05.2023

- Two clicks to optimized Wi-Fi installations via the LMC
LANCOM Management Cloud 1.00.152.0 / 25.04.2023

- Wi-Fi optimization with LANCOM Active Radio Control 2.0
LANCOM Management Cloud 1.00.151.0 / 04.04.2023

- Maximum data, failure, and access protection with the LMC
LANCOM Management Cloud 1.00.150.0 / 14.03.2023

- Secure WEBconfig access and CLI tunnel for GS-2000 switches
LANCOM Management Cloud 1.00.149.0 / 21.02.2023

- Accelerated add-in extension with new developer mode
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LANCOM Management Cloud 1.00.148.0 / 31.01.2023

- Advanced security features in the LANCOM Management Cloud

LANCOM Management Cloud 1.00.146.0 / 20.12.2022

- Feedback button in the Public Cloud

LANCOM Management Cloud 1.00.145.0 / 29.11.2022

- Improved usabilty with filtering in log tables

LANCOM Management Cloud 1.00.144.0 / 08.11.2022

- General improvements and bug fixes

LANCOM Management Cloud 1.00.143.0 / 18.10.2022

- Central management of your network security

LANCOM Management Cloud 1.00.142.0 / 27.09.2022

- Blocking websites harmful to minors for LCOS and LCOS FX devices

LANCOM Management Cloud 1.00.141.0 / 06.09.2022

- Wi-Fi 6E — The LMC is ready for the Wi-Fi VIP experience

LANCOM Management Cloud 1.00.140.0 / 16.08.2022

- Sorting and filtering in tables

LANCOM Management Cloud 1.00.139.0 / 26.07.2022

- Search function in the LMC

LANCOM Management Cloud 1.00.138.0 / 05.07.2022

- General improvements and bug fixes

LANCOM Management Cloud 1.00.137.0 / 14.06.2022

- Application Steering of the LANCOM R&S®Unified Firewalls

LANCOM Management Cloud 1.00.136.0 / 24.05.2022

- Cloud-managed hotspot vouchers

LANCOM Management Cloud 1.00.135.0 / 03.05.2022

- Firmware updates and device replacement of LANCOM R&S®Unified
Firewalls via the LMC

LANCOM Management Cloud 1.00.134.0 / 12.04.2022

- Protection of minors according to German BPjM filter

LANCOM Management Cloud 1.00.133.0 / 22.03.2022

- LAG support for stackable switches

LANCOM Management Cloud 1.00.132.0 / 01.03.2022

- Notification on active WAN backup connections

LANCOM Management Cloud 1.00.131.0 / 08.02.2022

- Cloud-managed switch stacking

LANCOM Management Cloud 1.00.130.0 / 18.01.2022

- Custom fields at organisational level

LANCOM Management Cloud 1.00.128.0 / 07.12.2021

- Custom redirection of the Cloud-managed hotspot




04 Release Notes - LMC Software Release up to 1.00.180.0

79 LANCOM Management Cloud 1.00.127.0 / 16.11.2021

- Link to external syslog servers
80 LANCOM Management Cloud 1.00.126.0 / 25.10.2021

- Anti-Virus for secure e-mail traffic
82 LANCOM Management Cloud 1.00.125.0 / 05.10.2021

-> Cloud-managed Firewalls & SD-WAN
83 LANCOM Management Cloud 1.00.124.0 / 14.09.2021

- Vimium support for barrier-free keyboard control
85 LANCOM Management Cloud 1.00.123.0 / 24.08.2021

- Dynamic DNS Service for upstream provider routers
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- Secure Terminal Access in a separate browser window
88 LANCOM Management Cloud 1.00.121.0 / 13.07.2021

- The LMC help portal - clearly arranged and just a one-click away
89 LANCOM Management Cloud 1.00.120.0 / 22.06.2021

- Convenient development environment for add-ins
90 LANCOM Management Cloud 1.00.119.0 / 01.06.2021

- Open Notification Interface
92 LANCOM Management Cloud 1.00.118.0 / 11.05.2021

- Extended Wi-Fi settings
94 LANCOM Management Cloud 1.00.117.0 / 20.04.2021

- Automatic license assignment
95 LANCOM Management Cloud 1.00.116.0 / 30.03.2021
97 LANCOM Management Cloud 1.00.115.0 / 09.03.2021
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1. Preface

As an intelligent network management and monitoring system, the LANCOM
Management Cloud automates and centralizes the entire network architecture in
terms of its WAN, LAN, WLAN, and Security. Even complex networking scenarios
with a large number of network components can be easily controlled, managed, and

optimized with the LMC, saving valuable resources such as money and time.

The LMC Public Cloud is available at https://cloud.lancom.de and is regularly

updated with new features and bug fixes.

This document describes the complete history of LMC software releases up to
version 1.00.180.0.
LMC Release Notes for versions newer than 1.00.180.0 can be found in the current

LMC Release Notes document.

LANCOM Systems GmbH does not assume any warranty or liability for software not
developed or produced by LANCOM Systems GmbH or distributed under the name
of LANCOM Systems GmbH, in particular not for shareware and other third-party

software.

2. Important notes

To ensure continued smooth operation with the LANCOM Management Cloud,
LANCOM devices with an old firmware version must be updated to a newer version.
The following firmware versions are the minimum requirement:

- LCOS 10.12.0147 SU3

- LCOS FX10.4

- LCOS LX 5.20 Rel

- LCOS SX 3.30.0417 RU3

To use all the functions of the LANCOM Management Cloud, we recommend using

the latest release version.

A list of the URLs and ports via which LANCOM devices communicate with the

LANCOM Management Cloud can be found in this Knowledge Base document.

& LANCOM

SYSTEMS
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3. New features, changes, and history
LANCOM Management Cloud 1.00.180.0 / 03.12.2024

Sustainable networks with LANCOM Active Power Control

APG-ActivePowerControl v " v
A s Y000 Q WH @D Priect Administator
ol

ions > Active Power Control

@& Active Power Control

Access Points options to save energy

LANCOM Sustainabity Mode: Reduction of capabilies in case of inactive clients

Devices

78

Energy consumption report
Generate report for current month

Month Reports
October 2024 & Download repor
September 2024 L

‘
August 2024 Lo

© 2014~ 2024 LANCOM Systems GbH Guided Tour Project Data protection notce | Terms of use | mpint

In the face of increasing demands on network performance, the associated rise

in energy costs and the growing desire for CO2 neutrality, we present LANCOM
Active Power Control (APC)—an intelligent solution for sustainable networks. This
enables energy resources to be used efficiently, which is good for the environment
and for the budget. With the launch of APC, you can take advantage of LANCOM
Sustainability Mode and energy consumption reporting. Activation is carried out via
the LANCOM Management Cloud (LMC) under Project specifications > Active Power

Control.

LANCOM Sustainability Mode: Here, the capacity provided by the access points
is reduced to the bare minimum during periods of low client activity. This reduces
the power requirement and leads to energy savings without compromising
performance. Once this option is enabled, all compatible access points in the
project are flagged for LANCOM Sustainability Mode. Full activation occurs during

the next rollout.

Energy consumption report: Gain detailed insights into the monthly energy

usage of all LANCOM network components (access points, routers, firewalls,
switches) within a project. Reports are downloadable as an Excel file under “Energy
consumption report” and offer in-depth analysis at the project, device type, and
location levels.
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LANCOM Active Power Control is continuously evolving with new features. Look
forward to additional energy-saving functionalities and enhanced monitoring tools

to further optimize energy-efficient networks.

Preview: Have you been looking forward to planned configuration rollouts and
firmware updates? Discover the new feature “Scheduled events” now in your device
overview. Detailed information, including step-by-step instructions, will follow in

the coming weeks.

Improvements
- API keys for interacting with SIEM APIs can now be created under ‘Project
specifications / External services [ SIEM'.
- Within organizations, projects can now be opened in a new tab.

- Sites can now be opened in a new tab.

Bug fixes
- Fixed Ul issues with an empty list of security profiles and disappearing filters
in the device list.

- Schedules in the project settings can be created correctly again.

& LANCOM
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LANCOM Management Cloud 1.00.179.0 / 13.11.2024

Addition of the “Type” column in the device table

[ o B &

Devices
+ Add device Activation codes || Fierby v Create tableview || G || &

© Update rollback

Outdated

© Update aborted

Xs-5110F Switch e © Notsupported
00f9 selected

100/ page v

< | ©2014 - 2024 LANCOM Systems GmbH Guided Tour Project

The clearer the overview, the easier the management! The newly added “Type”
column in the device table of the LANCOM Management Cloud enhances this
clarity. This small adjustment has a significant impact, as the “Name” and “Model”
fields alone don’t always intuitively reveal a device’s category. With this addition,
you can now immediately see whether your LANCOM network components are

routers, access points, switches, or firewalls. Sorting and filtering by device type is,

of course, also available.

Improvements
- The revised area for user profiles can now be expanded to include new topics.

- New function in the LMC console to remove 2-factor authentication for a user

- The LMC now also forwards usage information (data consumption and
connection time) to the configured external captive portal.

- The default interval for DPS overlay warnings is now correctly displayed as 0

instead of 5 minutes.

Bug fixes
- The handling of networks with duplicate names has been corrected.
- A problem with low contrast in the device table has been fixed.
- The link in the banner, which provides quick access to unlicensed devices,
now works under all conditions.
- An optional parameter in the Swagger documentation has been fixed:
auth_service (two endpoints touched: a) accounts/{accountld} b) accounts/

{accountld}?content=meta)
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LANCOM Management Cloud 1.00.178.0 / 29.10.2024

Wi-Fi 7 in the cloud!

& Lancom | < | e

Discover the extended monitoring functions of the new Wi-Fi 7 access point
LANCOM LX-7500! The detailed view of the Wi-Fi 7 device now provides the

following new information:

1. Current power information: In the device overview, you will see the new
“Power Info” tab. Here all details regarding PoE mode, PoE standard, and power
consumption per Ethernet port are clearly summarized. In addition, you can see
under “Power status”, for example, whether the access point is supplied with
sufficient PoE power for the full scope of functionalities or whether a fail-safe
hitless failover is guaranteed. The new “Power drawn” widget also provides a
graphical overview of the minimum, average, and maximum power consumption
over the last 24 hours.

2. Wi-Fi 7 in dashboard and device overview: The Wi-Fi 7 standard, also known
as IEEE 802.11be, has been integrated into the existing widgets, such as “Wi-Fi
networks” and “Wi-Fi users”, in the “Mode” and “Data rate” sections.

3. Mounting information: The “Device Info” section now not only displays the
location, but also the type of mounting (e.g. Wall 0°). It clearly indicates, through
icons and tooltips, whether the installation was done correctly or if adjustments are

needed for optimal coverage.

Learn more about LANCOM Wi-Fi 7 or the Wi-Fi 7 technology to achieve secure,

sustainable, and automated network management with the LMC!



https://www.lancom-systems.com/products/wireless-lan/indoor-access-points/lancom-lx-7500
https://www.lancom-systems.com/products/wireless-lan/wifi-7-access-points
https://www.lancom-systems.com/technology/wifi-7
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Improvements
- Improved sorting in the table ‘User profile » Memberships’
- New language support for Hotspot

- DPS overlay failure warning

Bug fixes
- Some minor problems with the device table have been fixed.
- The link to the firewall web interface in the device table has been corrected.
- Adaptation of directives from the former UiCoreModule

- Floor plans are now displayed correctly.
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LANCOM Management Cloud 1.00.177.0 / 01.10.2024

More efficiency for hybrid teams thanks to LTA Multi-Domain Access
LANCOM Trusted Access (LTA) with Multi-Domin Access provides hybrid,
decentralized teams with secure and seamless access to internal network segments.
This significantly facilitates collaboration with external employees. Through external
login domains, they receive temporary, secure access to the necessary network
areas to retrieve relevant information for their tasks. User accounts of additional
domains must be enabled in the Identity Provider (IdP), allowing the LTA client to
permit logins from additional external domain users. The logged-in users can be
viewed via Dashboards > LANCOM Trusted Access.

Improvements
- Improvement on handling of not found (deep) links and URLs pointing to
certain items
- Improved visual differentiation between official and custom authorities /roles
- Added an explicit confirmation on switching the central site role of a VPN

network to a different site

Bug fixes
- A problem with the sorting in the firmware dialog is fixed
- A problem with the device status widget for new project was fixed

- Update of the logo and background for the hotspot

& LANCOM

SYSTEMS
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LANCOM Management Cloud 1.00.176.0 / 11.09.2024

More convenience and security for configuration comparison

LANCOM
Management Cloud

{«  Dashboard
¢ Networks
Security
sites
Devices
> Add-ins
1t Project specifications

Management

),
Q w Project Adminisrator
Devices > Device : Lancom-GS-3652X (LANCOM GS-3652X) Device actions v
Overview  Position  Detail configurati Variables  System information  Device log 0 Help
Basic Rollout (preview)  Comp: Config actions v
Source T Source 2 Mode:
Basic configuration v Rollout configuration Show passwords  Side-by-side v

1 system/Information/General configuration/System contact
2 oD: 14.1.1.1.5
Value

e
5 system/Information/General configuration/System name

1 systen/Information/General configuration/Systen contact
2 om: 14.1.1.1.5

3 Value:

2

5 system/Information/General configuration/Systen name

6 O0ID: 14.1.1.1.6
7+ Value: Lancom-GS-3652X

8

9 system/Information/General configuration/System location

10 0ID: 14.1.1.1.4

11 Value:

12

13 System/Management Access/Device passuord/Enforce password policy
14 0ID: 14.1.3.1.1562

15 Value: OFf

6 0ID: 14.1.1.1.6
7— Value: 65-3652X

9 Systen/Information/General configuration/System location
10 0D: 14.1.1.1.4
11 Value

13 Systen/Management Access/Device password/Enforce password policy
14 OID: 14.1.3.1.1502
off

15 Value:

16 16

17 £ ; in device passuord 7 Access/Device p device password
Rollout Assistant 18 OID: 14.1.3.1.1501 15 OID: 14.1.3.1.1501

19 Value: *** 19 Value: ***
Live Chat 20 20

= 21 hi % 241 hidden ines
Help %2 (1] 8 (48)  [3] Disabled (0)  [4] Passive ©  [2] 0FF (0) 262 [1] Port 48 (48)  [3] Disabled (0)

26 ) [3] Disabled (@) [4] Passive (@) [2] off (@) 263 [1] Por (49) 3

System Information

Data protection notice | Terms of use | Imprint

© 2014 - 2024 LANCOM Systems GmbH Guided Tour Project

Customize the configuration comparison to suit your preferences: Changes between
two configurations are highlighted not only with row markers but also in content,
making it easier to focus. Simultaneous horizontal scrolling of both configurations
and the ability to hide irrelevant rows improve the overall overview. You control the
appearance of your interface: Hidden sections can be fully revealed with a click or by
dragging and dropping them back in row by row. Additionally, your preferred display
format - side by side, stacked, or inline —is saved for future access. To protect
against unauthorized access, changed passwords are no longer displayed by default.
Discover the new features of the configuration comparison by clicking on a router,

access point, or switch under “Detail configuration.”

Improvements
- Only Public LMC: Implementation of secure access to the LMC by LANCOM

Support for customer support (ISM-240205)
- Uniform behavior in the device table when the mouse pointer is moved over an

entry

Bug fixes
- Corrected country selection for changing an address in the account

management
- A problem with the website import when setting a standard DHCP gateway

has been fixed.
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- A problem with the display of new text content in the device overview has
been fixed.

- Automatically created device passwords with a length of 15 characters
sometimes did not match the password restrictions of the device. The
algorithm now always creates valid passwords.

- The antenna gain is now set correctly in the SD-WLAN configuration for LCOS
LX-based access points.

- The syslog is how correctly deactivated on switches of the SX series if this has
been configured in the LMC.

- The network overview page now remembers the selected settings for the
page length.

- The behavior after editing and deleting a variable has been corrected.

- The Polish translation of the hotspot has been revised.

- After clicking on an entry in the device compact view, the compact view is no

longer exited.

LANCOM

SYSTEMS
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LANCOM Management Cloud 1.00.175.0 / 20.08.2024

Integration of external hotspot providers

Create Hotspot Network

No preview available for external captive portal

For more flexibility in hotspot provision via the LMC, you can now also integrate
third-party hotspots that offer RADIUS interfaces for authentication and
authorization. The centralized management via the LMC allows you to ensure
uniform security policies for the entire network. To do this, create the hotspot under
Networks > Add network > Hotspot network and select “External” for Captive Portal.
In addition to the network name and IP range, enter the external URL and up to three
RADIUS servers. Simply assign the new hotspot network to the desired locations.
This way, hotspot users are forwarded directly to the portal of the external hotspot

provider when they dial in.

Improvements

- The ‘Config Diff’ feature is leaving beta status.

- Add-in names can now be 64 characters long.

- Passwords for devices that are configured globally in the project settings can
now be up to 30 characters long. New, random, individual passwords will use
this length by default.

Existing passwords are not changed. If a device does not support the new

length, the password is shortened and this is indicated with a log entry.

& LANCOM
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Bug fixes
- The exclamation mark in front of the beta label has been removed.
- The loading spinner has been restored in the device table while a
configuration rollout is taking place.
- The licensing filter in SPLA projects has been removed from the device table.
- Fixed a problem in the device table where the configuration column could

jump when the configuration status changed.
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LANCOM Management Cloud 1.00.174.0 / 06.08.2024

Improved overview with color optimization of the device table

LANCOM § LMC-Tutorial v (o) Jane Doe v

{“ Dashboard Devices

# Networks FYPET civation codes | Filter by Create tableview | |G X || @

Security
Status A Name * Model Serial Number Site 1P Address License Configuration Fimware

» SIS Online Router_UP 1781EF+ 4004929032100073 Nuersele 1010.35.78 @ Expired Up to date 10.20.0369 RU4

Detices) @ offline Router Wue  1800VAW-4G  4005041432100006 2 Expired Up to date 10.80.0345 RU2

1
> Add-ins Q offline Switch_Lager  GS-2310P+  4004806220000375  Buro urg 1 OK (12.11.2024) Outdated 332.0012

ger GS-2328P  AO57116AR4300004

t  Project specifications Online OK (1211.2024) Initialization pending 3320012

Management Preconfigured LN-860 4005004932100130 Biiro-Hamburg 10.0.0190 OK (14.06.2025) Outdated 10.20.0369 RU4

0 0f 5 selected

Rollout Assistant
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Reduced in color, optimized in function: the new, subtle appearance of the device
table provides an even more user-friendly LANCOM Management Cloud. Now,

only those areas are highlighted that could currently require action on your part.
These include warning and error messages for the device status (“offline”) and
configurations (“outdated”). All other harmless messages are displayed in reduced
form. This means you are automatically less distracted, can recognize changes to all

devices more easily, and can therefore concentrate on the essentials more quickly.

Bug fixes

- Problems with the new table design have been resolved.

- If the selectable values of a variable type based on a string selection are
changed and the selected value is not available any more, a meaningful error
message will be generated.

- An error in the generation bit field values was fixed in the add-in developer
mode.

- Alink directing to the non existing detail configuration of a Unified Firewall in
the logs is removed.

- An error message that appeared when resetting the password of an
unregistered user has been improved.

- Improvement to avoid creating unnecessary network objects on the Unified
Firewall when using LTA in Split Tunnel mode

- Public LMC only: A problem with the usage data provided in the organization
was solved. Please note that the data will be provided with a time delay of a

few days in the coming months.
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LANCOM Management Cloud 1.00.173.0 / 09.07.2024

SIEM integration service for cloud-managed LANCOM R&S®@Unified
Firewalls

Robust security management is essential, especially for larger organizations and
managed service providers (MSPs). A centralized Security Information and Event
Management (SIEM) system helps organizations detect, analyze, and respond to

security threats quickly, preventing damage to business operations.

We invite you to enhance your SIEM with our integration service for cloud-managed
LANCOM R&S®@Unified Firewalls, ensuring comprehensive detection of attacks on

your network infrastructure.

Compliance with market-leading SIEM systems

Our solution drastically simplifies integration with popular SIEM systems like
Microsoft Azure Sentinel, Splunk, Enginsight, Wazuh, and Logpoint. The LANCOM
Management Cloud (LMC) collects event logs from all managed Unified Firewalls

in a network, providing a single endpoint for SIEM systems to retrieve all logs in
standard JSON format. This setup ensures quick visibility of network infrastructure
attacks, enabling rapid response to threats such as viruses, malware, and DDoS

attacks.

Easy setup with the LANCOM SIEM integration service
Our experienced support team will assist you with an uncomplicated integration
process:

1. Create a ticket with the LANCOM support team: Open a support ticket and
submit the request for the SIEM integration service.

2. LANCOM support contacts you: Our team prepares the necessary
configurations for the Unified Firewalls and the LANCOM Management Cloud.

3. Receive a security token: After setup, you will receive a security token for
secure communication between the LMC and your SIEM system.

4. Rollout of the configuration: At a time of your choice, you roll out the
configuration of your Unified Firewalls via the LMC and update their firmware
if needed.

5. Configure the interface in your SIEM: If required, we provide all the

necessary information to retrieve and analyze the logs.
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Technical prerequisites

- Your LANCOM R&S®@Unified Firewalls (all models) are managed in the
LANCOM Management Cloud (LMC).

- Minimum firmware version:
o LCOS FX 10.13.6566 (REL) or higher
e LCOS FX-11.0 or higher

- The firewalls are assigned to a location and configured as a gateway

- You have your Cloud ID or UUID at hand

- You have access to the LMC to update the firewalls and roll out the

configurations.
By integrating cloud-managed Unified Firewalls into your SIEM, you can optimize
your security processes and safeguard your IT infrastructure. Our integration service

ensures a smooth rollout.

Get in touch with us today!

Improvements
- Some optimizations regarding the BETA function ‘Compare configurations’

- UX improvements when changing the role of administrators

Bug fixes
- In some cases, there were discrepancies in the SPLA usage data for the month
of May in the downloadable detailed report.
The data has been corrected.
- A problem with large tables on the Edge browser has been solved.
- For project viewers, the ‘License’ tab and the ‘Initial Rollout Firmware’ section
were displayed, even if they were not accessible.

- Long project names in the membership table are now wrapped correctly.
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LANCOM Management Cloud 1.00.172.0 / 18.06.2024

Full transparency before rollout thanks to configuration comparison

Overview  Position  Detai configuration ~ Wi-Fi  Variables  System information O Help
Basic configuration  Rollout configuration (preview) ~Compare configurations Config actions v
Source 1: Source 2: Mode:
Device configuration v Rolloutkonfiguration Side-by-side v
Management/Allgemein/Geratenane Managenent/Al1gemein/Gerétename
0ID: 13.2.1 0ID: 13.2.1
Value:

Value: LX-6406_ex_lc-e226_lc-cloud

Management/Allgemein/Standort Management/Allgemein/Standort
oID: 13.2.11.9 oID: 13.2.11.9
value: value:
Management/Allgemein/Adninistrator Management/Allgemein/Administrator
oID: 13.2.11.10 oID: 13.2.11.10
value: value:
.. 186 hidden lines ... ... 146 hidden lines ...
Management/Erweitert/Syslog/externe Server Managenent/Erweitert/Syslog/externe Server
oID: 13.2.22.2 oID: 13.2.22.2
[1] Name  [7] IP-Adresse  [8] Port  [9] Protokoll [1] Name  [7] IP-Adresse  [8] Port  [9] Protokoll

The practical configuration comparison gives you a detailed insight into the specific
changes made by the rollout, particularly to the device configuration. This tool
precisely shows you the sections in the device configuration that are overwritten
by the LMC rollout configuration. The advantage: you get a clear overview of all
changes in your device configuration before the rollout, minimizing risks from
unforeseen results. Test this feature in the “Detail Configuration” tab of your

routers, access points, or switches!

Improvements

- Usage details on SPLA organizations can now be sent once a month.

Bug fixes
-> The DHCP settings at site level now check whether the configured default
gateway belongs to the assigned network.
-> Project members can now browse through long add-ins.

- A problem with the device and site tables on Edge browsers has been fixed.
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LANCOM Management Cloud 1.00.170.0 / 15.05.2024

Trusted Internet Access: Mobile working as secure as in the office
LANCOM Trusted Access (LTA) now supports Full Tunnel operation (“Trusted
Internet Access”), allowing all data traffic from connected LTA clients to be routed
through the central LTA gateway. The advantage: activated security mechanisms on
the gateway, such as Anti-Virus or Content Filter, are also applied to external web

/ cloud-based applications. Full Tunnel operation can be enabled under ‘Security >
LANCOM Trusted Access > Client configuration’. Security settings for LTA users can
be adjusted in the “LTA users” profile under ‘Security > Profiles’. Further information

can be found in the FAQs or the tech paper LTA system architecture.

mmmmmmmmmmmmmmm Gatowiay I or domain L netuork T ONS resolution
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Improvements
- The grouping of the firmware is now based on the model and the current
firmware of the devices.
- In the firmware dialog, you can now choose to exclude selected devices/
groups from the update.
- The rollout assistant can now be used as a project member.
- Extensions to the cloud hotspot

- Packet filter: AH_ESP can now be used in connection destinations.

Bug fixes

- A problem with the middle mouse button to quickly open devices in the device
list has been fixed.

- Spontaneous error “invalid destination” during LTA login fixed

- The number of LTA users could be wrong.

- Spontaneous exception in the site view

- When editing a membership, the ‘Technical administrator’ role could not be
selected.

- When using 2FA, the terms of use could not be accepted.
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LANCOM Management Cloud 1.00.169.0 / 16.04.2024

Customized device overview using savable table views

Focus more quickly on what you actually need: You can now customize your device
view, including filter settings, to suit your needs using the “Create table view”
button. The views you create are only visible to you and can be saved with an
individual name so that you can access them again at any time. For example, move
the table columns you are interested in using drag & drop, change the columns to
be displayed under “Configure columns”, or filter the view using “Filter by” to make

your daily workflows even more efficient.

Cavcon
B HoSSthentcovs Q LR yw—

[« Dashboard Devices

& Networks + Add device Activation codes  Filter by v View: Config / Wuerselen ~ Createtableview & & @@

Security Default view
Site: Wuerselen X Configuration: Up to date X

) View: Config / Wuerselen ¢
Sites

8 8

Status - A # License Name ~ site Configuration Serial Number
oK

oK

View: Offline devices. s
S——— Wuerselen 4007907118100333

Devices vang
Warehouse 2.22 Wuerselen 4005407118100399

Add-ins
oK

Wuerselen 4005407118100312
Wuerselen 4007777118100390
Office 3.445 Wuerselen 4005407118001212

s’ Wuerselen 4005407118100398
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Improvements
- The application templates for application management have been updated.
- The device tunnel service now provides an endpoint to check whether the

device has correctly initiated a tunnel session.

Bug fixes

- Pressing the Enter key in the editing dialog of variables now saves the content
instead of discarding it.

- Spontaneous error messages during LTA login (invalid destination) have been
fixed.

- In the ,Networks’ area, the view of the ,Sites’ tab now also works if a large
number of sites have been assigned to a network.

- Updated the wording of the title in the log table regarding the LCOS restart in

the event of a watchdog.
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LANCOM Management Cloud 1.00.168.0 / 26.03.2024

More comfort with multi-language support for the cloud-managed
hotspot

“Wifi en espafiol? jPor supuesto!” — take full advantage of the language diversity
when using the Wi-Fi hotspot via the LMC! Add translations of up to seven
languages directly when creating a cloud-managed hotspot under Networks > Add
Network > Hotspot Network > Translations. By selecting a default language, your
hotspot users will see the preset language and the option to change the language.
Simply assign the new hotspot network to the desired sites and your Wi-Fi hotspot

will easily be available to visitors in different languages.

LANCOM Systems ~
Project Q

orks > Create Hotspot Network

Blcoic so I e

Global IP range

172160.0/24

VLAN ID

909

Default Language

Wi-Fi gratuito

E taton 1 Acceso a Internet

Terms of f Service

Imprint & Footer Conectar

Translations
s 8

Add translation

Advanced Settings
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Improvements
- Uplink mode is now also available for LAG ports.
- The categories in the ,Application Management’ section have been updated.

- All notifications can be closed at the same time.

Bug fixes

- When creating new WiFi networks, the key field is correctly available if
WPA?2/3 is selected.

- The actions configured in the action table are saved correctly in the detailed
configuration.

- New projects with special characters can now be saved correctly.

- If a system variable UF_default_IF is set for a Unified Firewall, only the
affected Unified Firewall is set to obsolete.

- More clarity in the log message when administrator roles are changed
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- BPjM filter warnings on the security profile settings page are now always
displayed correctly.

- The tooltip information about active packet filter rules in the ,Security /
Profiles’ table overview now shows the correct number of rules.

- The ,LMC Top Users’ and ,Top Applications’ data were labeled as gigabytes
and terabytes respectively, although they are actually gigabits and terabits.

- Switching the monitoring from daily to hourly removed graphs on 5 unit stacks.

- The monitoring diagrams were sometimes empty.

- DPS Widget: Multiple networks with different central locations are not

displayed.
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LANCOM Management Cloud 1.00.167.0 / 05.03.2024

Precise troubleshooting with direct links to the source of the error

The time-consuming search is coming to an end: you can now benefit from
optimized error notifications! For example, you can save yourself the laborious task
of detecting errors in the event of invalid configuration parameters relating to object
IDs (OIDs) in the device configuration. Clicking on the link displayed in the error
report takes you directly to the corresponding point in the configuration preview in
the detailed configuration of the device. This allows you to identify and localize the

source of the error much faster!

vice : HOME-VPN-GW (LANCOM 1800VAW-4G) Device actions v

Wi-Fl Vaiables  Systeminformation  Device log

5 login failures

Guided Tour Project Datapr

Improvements

- Device tunnel log messages have been added to the device log if a dedicated
tunnel could not technically be established after the tunnel was initialized.

- The device tunnel API layer now only allows to initialize a tunnel to a device if
the device is online; if the device is offline, the request is rejected.

- Improved warning message that the network is still assigned to the location
when the network is deleted

- When switching between full tunnel and split tunnel mode, the tunneled
networks of the split tunneling were removed, now they are retained and
deactivated by the system when switching to full tunnel.

- The configuration of static DHCP leases is now supported in the site-specific

network settings.
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Bug fixes

- A problem with the location assignment in the device table has been fixed.

- A problem with the visibility of device list filters has been fixed.

- The network settings at site level were restricted if the network mode was
set to “use the same network for each site”. It is now possible to configure
settings for gateway IP addresses.

- The detail configuration now shows the correct values for the time base
settings in the cron table.

- The ‘Description for networks’ field now also accepts spaces.

- The transmission power ranges have been corrected for 5 GHz WiFi settings.

- In the device overview for switches, the ‘Save’ button is only displayed if the
configuration has actually been changed.

- The VLAN input field of the network configuration is now always active during
the creation and editing of a network.

- If the gateway IP of a site-specific network is changed, the changes are

correctly forwarded to the front end.
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LANCOM Management Cloud 1.00.166.0 / 13.02.2024

Easy-to-view site assignment of a network

At which sites is a particular network used? How can networks be quickly removed
from sites? Answers to these questions are now provided by the clear display in the
~hetworks” menu entry. Under ,Site count”, you can see at a glance how many sites
your networks are assigned to. Click on the number to go directly to the new
detailed overview ,Site” of your selected network. Here you can remove the
network assignment of one or more sites at the same time if required. In addition, a
warning now appears when you delete a network, informing you if the network is

still assigned to at least one site.

LANCOM . -
& Management Cloud Q = A Project Administrator

[ Dashboard Networks

%  Networks —+ Add Network Delete networks.

Security

Status Name * P range VLAN Internet = VPN ¢ Hotspot Security Site Count
Sites Employe 10.0.00/8 untagged v/ -
GuestNetwork ~ 17216.00/24 999
ERP 1722356024 2048
> Add-ins ® Management 19216800/16 444

Devices

[N B EEN

v

AN RN
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Improvements

- Errors in the LMC logs that refer to OIDs in the device configuration now
contain a direct link that points to the corresponding part of the configuration
to localize the source of the error.

- There are now many smartphones that are equipped with more than one rear
camera. Previously, the rollout assistant automatically selected a camera when
scanning the serial number via barcode on a device, but this was not always
the best one. Now it is possible to select the desired camera during the scan.

- According to a recommendation by the German Federal Office for Information
Security (BSI), RSA-based certificates should have a key length of at least
3072 bits. Therefore, the pairing service will generate pairing CA keys with a
length of 3072 bits instead of 2048 bits during the next automatic annual CA
update.

If devices are re-paired from now on or are already paired and are
automatically re-paired within a year, they will also generate RSA keys with a
length of 3072 bits for the device-client certificate in relation to the LMC-TLS

communication.
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A technical impact is that the devices will need a little more time during the
pairing process to generate the longer key length.

- Optimized display of error messages for invalid configuration parameters with
a link to the configuration preview in the detailed configuration.

- A filter can now be used to quickly search for countries for addresses.

- The device CSV import no longer aborts when a device is imported again.

- The new LMC scripting manual has been linked.

Bug fixes

- The function ,enableBitByOidAtPos’ of the LMC add-in now works correctly.

- The * character is now permitted in the configuration for RADIUS servers in
the LMC.

- A display error in the detailed configuration in the tariff selection for Wi-Fi has
been corrected.

- Sometimes the automatic selection for the DHCP start address selected an
invalid network ID. This behavior has been corrected.

- If there was a change for the WAN connections at site level, too many devices
were set to ,Configuration obsolete’. The selection of affected devices is now

more precise.

& LANCOM

SYSTEMS




30 Release Notes - LMC Software Release up to 1.00.180.0

LANCOM Management Cloud 1.00.165.0 / 23.01.2024

Central administrator management at organization level

Reduce time-consuming, manual activities when adding or deleting LMC
administrators: Activating administrator inheritance gives members of an
organization access to the subordinate projects. As the organization administrator,
you control this access by selecting a role that is inherited to all subordinate
projects in the organization. If you want to give administrators access to all projects
but do not want them to have the administrative rights of an organization
administrator, simply assign them the new ,organization viewer" user role under
Management > Administrators. For projects in which administrator inheritance
should not be activated, this can be excluded under Project specifications > Basic >
Project access. All information on the LMC roles and rights can also be found in

compact form in the Infopaper.

Properties minist Log

Administrator inheritance

Enable admi

Memberships

Filter by ~

Status E-mail ~

Link expires in Role Last activity

Organization Administrator 26.01.2024 11118

00f 1 selected
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Improvements

- Project administrators can now export device data for the project from within
the device table (e. g. for inventory purposes).

- Administrators can now assign devices to sites directly in the device table
using an improved site filter.

- If devices without a position or address are added to a site, they are now
automatically assigned.

- The ,Device position’ page has been redesigned and now allows larger images

of the device installation to be uploaded.
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- In the Wi-Fi profile, the ,Minimum supported transmission rate’ is renamed to
,Base rate (beacons, multi- and broadcasts)’ and applied to all corresponding
LCOS LX settings.

- Support for additional languages in the hotspot menu

- New design for the rollout assistant web application

Bug fixes
- Sporadic LTA Idp synchronization errors have been fixed.
- Incorrect logging of the LTA Idp synchronization status has been fixed.
- The LTA main group was sporadically no longer displayed after
synchronization.
- The workflow for resetting the password did not work if the form was used a

second time.
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LANCOM Management Cloud 1.00.164.0 / 02.01.2024

A look back at 2023

We would like to use the turn of the year to thank all administrators of the LANCOM
Management Cloud. In 2023, many exciting projects with innovative solutions were
realized with the LMC. At the same time, we continued to develop and drive forward
the capabilities for the management of all network components. These key features

are just a few examples:

- LANCOM Trusted Access — Cloud-managed Secure Network Access
In addition to the central management of network components, the LMC also
enables the secure connection of employees to the company network — from
a single source! LANCOM Trusted Access (LTA) offers highly scalable remote
access that protects hybrid working, whether as a cloud-managed VPN or
based on the innovative Zero Trust principle. Start your onboarding today!

- Wi-Fi optimization with LANCOM Active Radio Control 2.0
Best Wi-Fi at the touch of a button: LANCOM Active Radio Control 2.0 (ARC

2.0) predicts the optimization potential of the Wi-Fi network based on real

usage data and automatically optimizes channels and channel widths.

Discover the full power of ARC 2.0 on our topic page!

- Efficient switch rollout thanks to centralized port templates
Network assignments to switch ports are simplified and assigned to the
devices ,zero-touch”. A major efficiency gain, especially with different port
assignments at different locations.
We have also modernized the design of the user interface with a new look. You
can already look forward to the further innovations that 2024 has in store for the

LANCOM Management Cloud. Thank you for your continued support and trust!
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LANCOM Management Cloud 1.00.163.0 / 12.12.2023

Your direct access to cloud-managed VPN

Centralized management of VPN users via the LANCOM Management Cloud (LMC)
is also worthwhile for smaller installations. You do not need a user database (Active
Directory), but can take immediate advantage of the remote access solution

LANCOM Trusted Access: to do this, select the option ,LMC-managed” under

Security > LANCOM Trusted Access > User management. Then copy the unique
identifier (TXT resource record) from the LMC and paste it into the DNS
configuration of your domain. After a brief check, the LMC verifies the domain and
once you have entered your users’ e-mail addresses, you can immediately enable

them to use Trusted Access. Discover the LTA tutorials and trial versions today!

Project Admiistator

© First steps with LANCOM Trusted Access
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Improvements
- It is now possible to choose between 3 connection modes for the connection
setup of the LTA client in the configuration of the LTA client profile: Manual,
automatic or variable connection establishment (the behavior is identical to
the current standalone AVC client).
- The add-in developer mode now supports values of the bitmask type.

-> WWAN firmwares are displayed under ,System information’.

Bug fixes
- The stability of the tunneled WEBconfig access to LCOS FX firewall devices
has been optimized. The optimization is only active in conjunction with the
upcoming firmware release LCOS FX 10.13 RU3 (or higher).
- Error messages in the backend logs of the pairing service relating to cron jobs

have been eliminated; however, the messages had no impact on functionality.
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- Incorrect firewall rules were created for certain combinations of DPS with
manually created applications and assignhed DPS categories other than BE.
The resulting firewall rules are now shortened so that they are acceptable for
the device.

- A problem with the navigation on the page via the browser buttons has been
fixed.

- Some linked materials that were still based on the old design have been

updated.
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LANCOM Management Cloud 1.00.162.0 / 22.11.2023

LANCOM Trusted Access — Cloud-managed secure network access
With the LANCOM Management Cloud (LMC), you now not only manage your
network components, but also secure the connection of your employees to the
corporate network centrally. With the highly scalable remote access solution
LANCOM Trusted Access (LTA) and the new LANCOM Trusted Access Client, you

can protect hybrid work — regardless of whether you want to use LTA as a cloud-

managed VPN solution or on the basis of the future-proof Zero Trust principle with

granular network control. Find out which LTA level of integration is right for you,

start your LTA training, and test LTA for free for 30 days on the LTA onboarding web
pages.

> > LANC ted Access ’
o
Gateway status Licenses Event logs Endpoints 4
s Blocked

Improvements

- In the switch device overview, the port labels and information about assigned
networks can now be exported as a CSV file.

- If multiple ,0'-tagged default routes with different administrative distances
are created in the underlying detailed configurations, these are adopted for
automatically created SmartConfig default routes. This mechanism is only
available if the WAN connections are not explicitly specified in the project or
at the location.

- The displayed add-in console scripts from the configuration preview of the

detailed configuration can now be copied without line numbers.
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Bug fixes
- If an add-in is assigned to a network, only the associated device classes are
set to ,not current’.
- After use, the button for copying the device password is no longer blackened.

- Various visualization problems have been fixed.
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LANCOM Management Cloud 1.00.161.0 / 31.10.2023

Refresh of the LANCOM Management Cloud user interface

Already noticed? The LANCOM Management Cloud now has a new LANCOM look.
With a contemporary color palette and intuitively designed controls, the Cloud
gets a breath of fresh air, while the features remain in the familiar place. Discover
new colors and subtle design adjustments for an even better user experience. We

welcome comments and feedback on the new Cloud design.
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Qe 2 &

Improvements

- In the port template groups it is now possible to defing, if a selected port
should be operated in tagged mode or if an untagged operation is preferred.

- In the switch overview, a new port mode “uplink” can be assigned to individual
ports. This operation mode causes every vlan of the site being assigned to the
port either in hybrid or fully tagged way.

- Device list now optionally shows last contact time of offline devices.
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LANCOM Management Cloud 1.00.160.0 / 13.10.2023

Simplified management and more overview for switch stacks

From now on, you can also benefit from convenient port management for switch
stacks, so that individual and time-consuming port configurations of the stack
units are a matter of the past. The central, cross-network port template groups are
available for this purpose: Select one of your predefined port template groups for
each unit of a stack to conveniently reuse your port configurations even for new
stacks at different locations. The port template groups are assigned exclusively by
your explicit selection in the unit overview of the stack and require the port mode
.Network default for unit”. For even more overview, you can now additionally assign

individual names to your stack units.
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Bug fixes

- The channels can be selected correctly again in the Wi-Fi settings.
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LANCOM Management Cloud 1.00.158.0 / 29.08.2023

Centralized port templates for optimized switch rollout

Manual network assignments to switch ports could quickly become a challenge
if you needed different port assignments for switches with the same number of
ports at multiple locations. This is now remedied by extended, central templates,
so-called port template groups. You can create, configure, and apply up to 50
different templates yourself for the networks and device models offered (e.g.
26-port model). Your previous port templates are initially assigned to the default
group. You will find the port template groups under ,Networks > Selection of a
network > Switches’ and can easily map them to your devices on the site level for

even more , zero-touch”.
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Bug fixes

- The channels can be selected correctly again in the Wi-Fi settings.
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LANCOM Management Cloud 1.00.157.0 / 09.08.2023

Inspiration for your projects: Discover the new LMC website
We are pleased that you are using the LANCOM Management Cloud (LMC). With it,

you benefit from:

o Maximum productivity: Configuration adjustments, firmware updates,
monitoring & rollouts are automated and efficient — you save an average of
75% in time.

* More performance and security: VPNs, VLANSs, ports, and UTM rules are
defined and rolled out centrally. You can also securely connect remote
workstations in the shortest possible time.

« Immediate return on investment: Make efficient use of valuable resources
such as manpower, time and money. You can deploy new applications or
optimize Wi-Fi infrastructures at the click of a mouse without expensive

on-site visits.

We have summarized these and many other benefits and functions as well as
customer references and awards on our relaunched LMC website. We invite you
to use these benefits to win further projects or to use the materials, customer
references and use cases listed here as inspiration to further develop your own

network management concept.

Bug fixes

- Schedules can be edited and created again.

- Variables with user-defined variable types can again be used correctly in the
global add-in assignments.

- Change detection for add-in assignments works correctly again. The buttons
for saving or discarding are only displayed when changes are made.

- The auto-correction of the input field for defining the IP network has been
adjusted.

- Optimizations of the ARC 2.0 algorithm
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LANCOM Management Cloud 1.00.156.0 / 18.07.2023

Network extension & device setups within minutes

Are you already benefiting from ,zero-touch deployment“? Minimize your workload,
especially when integrating many new access points, as this is where the LMC really
shows its strengths: activate the project-wide location allocation based on the
device IP address and define an initial firmware for new devices under Project
specifications > Device startup. You can already register and configure your
devices in advance via serial number and PIN independent of location — the LMC will
then take care of everything else for you: if an Internet connection is established,
your access points are automatically identified, assigned to a location, and
immediately equipped with their pre-configuration. You can find more tips for a fast,

automated rollout in the techpaper LMC Rollout.
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Bug fixes
- Fixed a problem with rolling out the configuration just before the license
expires.
- CSV site and device imports were logged as system users.
- The hotspot password in the site-specific hotspot settings did not work.
- If the devices at a site have changed, the result of an ARC scan can continue

to be used for the unchanged devices without a rescan.



https://www.lancom-systems.de/pdf/techpapers/TP_LMC-Rollout_EN.pdf
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LANCOM Management Cloud 1.00.155.0 / 27.06.2023

Efficient, automated workflows with webhooks

From monitoring and troubleshooting to deployment and upgrades: As an
administrator, you rely on a holistic view of all network activities to respond quickly.
Using webhooks in the LMC saves you valuable time by flexibly communicating
alerts and notifications to messaging services and automation tools when an event
occurs. Set up your webhooks for Slack or IFTTT, for example, under Project

specifications > Alerts & Notifications > Webhooks and learn more in the Webhooks

techpaper.
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Bug fixes
- In the device license assignment dialog the current license status was not
shown.
- A display issue in the project specification dialog after saving the settings has
been solved.

- Anissue in the guided device replacement process has been solved.
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LANCOM Management Cloud 1.00.154.0 / 07.06.2023

Improvements
- In add-ins, the variable contents of particular devices can now be accessed
specifically via their serial number in order to use them for the configuration of

other devices.

Bug fixes
- The sender interfaces for communication with the LMC and the firmware
update server are now also set correctly in scenarios with the cloud-managed

hotspot.
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LANCOM Management Cloud 1.00.153.0 / 17.05.2023

Two clicks to optimized Wi-Fi installations via the LMC

Scan, apply, and roll out - that is all it takes to make your Wi-Fi more efficient, even
at sites with data-intensive applications, high user densities, or interfering third-
party external networks. LANCOM Active Radio Control 2.0 (ARC 2.0) does exactly

that job for you! After scanning the environment, the self-learning Wi-Fi

optimization solution automatically takes into account the individual usage behavior
of the Wi-Fi clients in your installation, predicts the expected Wi-Fi situation, and
evaluates it using the ARC Index. Enhance your ARC Index and get the most out of
your Wi-Fi installation! Find out your personal ARC Index potential now! Tips for

custom settings are provided in the ARC 2.0 techpaper.

Further improvements
- To better distinguish the LMC administrative roles from the network users,
the menu item ‘Management - Users’ has been renamed to ‘Management >

Administrators’.

Bug fixes
- The encryption settings for WPA3 wireless networks have been corrected.
- The behavior of a rollout of linked Central Site devices when the VPN feature
is disabled has been corrected.
- Optimizations of the calculation algorithm for ARC 2.0.
- Firmware updates and communication with the LMC could fail in certain
scenarios due to incorrect settings of the source interfaces. The selection of

source interfaces has been revised.
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LANCOM Management Cloud 1.00.152.0 / 25.04.2023

Wi-Fi optimization with LANCOM Active Radio Control 2.0
Ensure optimal Wi-Fi for any network size at the push of a button - directly via the
LMC! With the self-learning automation solution LANCOM Active Radio Control 2.0

(ARC 2.0), you can forecast the optimization potential of your Wi-Fi network based
on learned usage behavior. For this purpose, ARC 2.0 analyzes existing multiple
channel occupancies, taking into account external networks and access point
densities. In this way, you receive a clear comparison of the actual radio field
situation with a preview of the expected network status after adjustment. Clicking
on , Apply optimization” sets the most suitable channels and channel widths to
automatically adjust transmitting powers and provide radio capacity where it is
needed. Detailed ARC 2.0 settings such as prioritization, reservation, or exclusion
of access points or channels can be made for access points as of LCOS LX 6.10 and

other devices as of LCOS 10.72 under Sites > Site selection > ARC 2.0. Learn more

about ARC 2.0 in this tech paper and try it out right away!

Further improvements
- The landing page UUID of the cloud-managed hotspot can be set in add-ins
via a context variable (context.network.hotspotid).
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https://www.lancom-systems.com/technology/wi-fi-optimization-with-active-radio-control-2-0
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https://www.lancom-systems.com/products/firmware/lcos-lx-release
https://www.lancom-systems.com/products/firmware/lcos-release
http://www.lancom-systems.de/download/documentation/Techpaper/LANCOM-Techpaper-Active-Radio-Control-20-EN.pdf
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Bug fixes

- The detail configuration now allows the simultaneous deletion of multiple table
rows.

- Passwords can now be displayed again in the preview of the detailed
configuration.

- ToolTip display errors in switch port information have been corrected.

- Devices are set to,not up to date’ when variables are changed even if they are
not assigned to a site or network, but globally assigned add-ins are used.

- The commissioning process for devices with default configurations (manual or
automatic assignment during commissioning) has been corrected.

- For globally assigned add-ins, switch variables with user-defined variable
type can be used correctly again.

- Add-in developer mode outputs have been optimized for specific device
types.

- If VPN is disabled for a network, no rollout of the connected Central Site

devices is performed.
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LANCOM Management Cloud 1.00.151.0 / 04.04.2023

Maximum data, failure, and access protection with the LMC

While you protect your network via the LANCOM Management Cloud (LMC), we take
care of protecting the LMC itself in the background. With regular security audits,
encrypted data backups, and geo-redundant, certified, and sustainably operated
data centers in Germany, we minimize risks such as cyberattacks, data loss, and
service outages. For you, this means data sovereignty at the highest level. To find
out which data protection standards our LMC hosting meets in detail, visit our Cloud

security of the LMC website or read the LMC (Public) Data Protection and Data

Security infopaper.

Bug fixes
- A display problem with the help chat has been fixed.
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https://www.lancom-systems.com/pdf/infopaper/LANCOM-Infopaper-LMC-Data-Protection-and-Data-Security.pdf
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LANCOM Management Cloud 1.00.150.0 / 14.03.2023

Secure WEBconfig access and CLI tunnel for GS-2000 switches

We are continuously expanding the management options of the switches for you
via the LANCOM Management Cloud (LMC): Direct remote access to a device's
WEBconfig or command line interface (CLI) through the LMC saves system
administrators valuable time and greatly simplifies device access. With the securely
encrypted sessions tunneled through the LMC, you combine individual and global
management for GS-2000 series switches in one application as well. To do this,
select one or more switches (from firmware version LCOS SX 3.34 RU3) in the
device overview and click ‘Open terminal’ or ‘Open WEBconfig' in the selection
menu.

Please note that local configuration changes can be overwritten by a configuration

subsequently rolled out by the LANCOM Management Cloud.
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Further improvements
- The structure of routing rules and tables rolled out to LCOS FX devices has
been revised. This reduces the complexity of the routing configuration and the
overall number of requests required to set up the device, thus increasing roll

out speeds.

Bug fixes

- Anissue with the user support chat has been solved.
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LANCOM Management Cloud 1.00.149.0 / 21.02.2023

Accelerated add-in extension with new developer mode

Individually created add-in scripts are particularly useful for flexibly adapting your
LMC configuration to customer-specific network scenarios. Accessing
configuration data based on their object ID (OID) from the LMC is now even more
convenient: make your adjustments, e.g. for a switch, in the detailed configuration
and activate the new add-in developer mode under config actions. The LMC
automatically converts your configuration changes into an add-in-compatible
format that you can insert directly into your add-ins, saving you a lot of time. Learn

more about add-ins in the add-ins manual.
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Further improvements
- When a device in a project goes online for the first time, a notification is
displayed.
- The number of filtered locations is now displayed in the location overview.
- Anomaly detection notifications can now be closed.
- If a site’s access point does not support the country assigned to the site, the

device's configuration will not be written.

Bug fixes
- Fixed an issue with a disappearing filter in the device overview.
- Fixed an issue with a delayed status display (online / offline) in the device
detail view.
-> Locations can be updated again via CSV import.
- The automatic assignment of locations based on IP addresses works again.
- The notation of MAC addresses in the detailed configuration has been

corrected.
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- The date selection in the detail configuration works again.
- The VLAN ID of a switch port that is part of an LAG is set correctly when the

port is disabled in the individual port configuration.
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LANCOM Management Cloud 1.00.148.0 / 31.01.2023

Advanced security features in the LANCOM Management Cloud

We are further expanding the “Security” menu for you: For improved usability and a
more efficient workflow, you can now generate packet filter rules directly from a
security profile. Especially if you have a large number of security profiles and rules,
the project-wide search function helps you to locate the profile or rule you are
looking for more quickly in the LMC. To do so, simply use the keyboard shortcut

“ctrl + K“ (Windows) oder “cmd + K” (macOS). An overview of the continuously

developed security features can be found in our tech paper.

ent rule: Local Breakout Video Conference

Further improvements
- The design of the ,Administration - Licenses’ section has been revised.
- Improved overview within the security profiles

- The maximum number of floorplans has been increased to 25.

Bug fixes

- More robust error handling for the user’s language setting

- Added support for 6 GHz in the Wi-Fi Users’ dashboard.

- The SD-WLAN configuration now enables 802.11ax on 2.4 GHz for the
LANCOM routers of the 1800 series.

- The PoE status information for devices in a stack group has been corrected.

- The rollout of the device configuration via the action menu in the detailed
configuration now also offers to roll out Central Site locations if required.

- Changes to variables now generate log messages.

- If the setting of the default networks of the Unified Firewalls is changed in the
project settings for commissioning, only Unified Firewalls are now switched to

,not up to date’.
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- If the device overview of a switch is called up several times, the order of the
display of assigned networks remains unchanged.

- The DECT settings have been corrected in the detail configuration.
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LANCOM Management Cloud 1.00.146.0 / 20.12.2022

Feedback button in the Public Cloud

Your opinion counts — as you know best what enriches your everyday work and
what does not (yet): Which features of the LANCOM Management Cloud (LMC) are
particularly helpful and understandable? Which ones can we optimize further? We
ask questions like these not only to ourselves, but from now on to you as well: By
clicking on a feedback button, you can participate anonymously in a survey on a
specific function and contribute directly to improving the LMC. The blue buttons
can currently be found, for example, at the menu item “Security” or in the hotspot

portal. We are looking forward to your feedback!

Survey

Your opinion matters!

Please rate your experience using our security features:

Very Poor

Submit feedback >

Further improvements
- Microsoft Teams was added as an application for application management.

- Packet filter rules can now be generated directly from a security profile.

Bug fixes
- When notification is disabled, no alerts are issued for backup connections.
- Backup connection alerts are now issued when notification is enabled.
- A warning older than 365 days could neither be read nor deleted.
- Improved validation of CSV files when importing locations.
- The usability of dialogs has been improved.
- In a few cases, the location column and the corresponding filter were no
longer displayed. This misbehavior has been fixed.
- When transferring multiple devices to a new project, an unnecessarily large

number of success messages occurred. This misbehavior has been fixed.
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LANCOM Management Cloud 1.00.145.0 / 29.11.2022

Improved usabilty with filtering in log tables

With transparent and complete logging, administrators always have a full overview
of who made which change and when. Under ‘Management > Log’, you can
therefore view the log messages and can filter them. Using the drop-down menu,
you can either select from a list of predefined events and types or enter your
individual search term to find them more quickly. For example, you can view when
a license was assigned to which device and by whom. A click on the log entry will

then give you further information.
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Bug fixes

- Fixed a problem with searching for firmware files in preconfigurations.

- The display of the expiration date for short-term expiring cloud licenses in the
device table was incorrect.

- After disabling the security functionality, the exceptions on LCOS FX devices
were not removed.

- In some cases, the configuration of a vRouter newly paired with the LMC could
not be rolled out.

- Uncritical security aspects of the terminal & webconfig tunneling endpoint of

devices have been optimized.
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LANCOM Management Cloud 1.00.144.0 / 08.11.2022

General improvements and bug fixes

Improvements

- The country setting on site level is now automatically used for the country
defaults of the WLAN settings if a country is set.

- To correctly determine the Wi-Fi properties of an access point, an indoor or
outdoor operating environment can now be specified.

- From the network overview there is now a direct link to the security profile of
the networks.

- The search function now also supports searching for security profiles and
rules.

- The service overview now also displays the versions of the available
description files (DSC) for different firmware states.

- The user interface of the detail configuration has been fundamentally revised.

- In the LMC log filtering can now be done according to a log type.

- In the hotspot operator portal, it is now possible to revoke a voucher.

Bug fixes
- A problem with the display of the license status in the device overview has
been fixed.
- The arrangement of Google Maps icons has been corrected.

- Several problems with the display of licenses have been fixed.
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LANCOM Management Cloud 1.00.143.0 / 18.10.2022

Central management of your network security

With the new menu entry ,,Security” you can now keep an eye on your security
settings in one place. A security profile is automatically created for each network in
your LMC project, or your existing settings and rules are migrated there. With just a
few clicks, you can create rules such as those for Application Management, Content
Filter, and Packet Filter globally for all networks and assign them to the correspon-
ding security profiles. Under ‘Security > Profiles’ you can clearly see which security
properties are effective in the respective network. Learn more about the cloud-

managed security concept in our tech paper.
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For every network, a security profile is created automatically. By using the tabs "Application Management".
“Content Filter" and "Packet Filter" you can create rules that can be activated inside of the profiles. By using

these security profiles, the security features of your devices can be controlled per network in one central
location.

A Content Filter rule is already available, which provides typical settings to protect against malware,
malicious websites and pornographic content. For using it, activate the rule in the security profile of a
network, and roll out the device configuration. Content Filter rules can be created, changed, or deleted on
the corresponding tab, and used in a security profile.
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Improvements
-> Revised license assignment dialog
- The display and assignment of a license is now also possible in the device

overview.

Bug fixes
- Preconfigurations for GS-4000, XS-5000 and XS-6000 series switches can be
created again.
- Hidden tabs are automatically shown again after assigning a license.
- Corrections regarding firmware status output via API
- When querying the site list via the API, sites that have already been deleted

are no longer output.
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LANCOM Management Cloud 1.00.142.0 / 27.09.2022

Blocking websites harmful to minors for LCOS and LCOS FX devices

Reliable and effective youth protection is a top priority, especially in schools and

youth facilities. Therefore, the officially recommended website filter of the German

Federal Review Board (BPjM) blocks content that is classified as harmful to minors

in Germany. Continuous updates and extensions are guaranteed. You can activate
the BPjM filter for all LANCOM R&S®Unified Firewalls with LCOS FX 10.8 onwards
and now also for all LCOS devices with LCOS 10.70 under Networks > Content Filter.

Overview Wi-Fi Switches @ Security @ Application Management

Please choose a category in order to create a rule

- Block media harmful to minors (according to German BPjM)

- Blocked Content Filter category groups

Blocked Content Filter categories

Add-ins Variables

Allow override by usel

Allow override by use Comment

Default CF blocking rule /*

Further improvements

- Support for UF High Availability in the device table / system information

Bug fixes

- A problem with the display of the status of (stacked) enterprise switches has

been fixed.

Announcement

- Please note that the license management in the LMC will change from

18.10.2022: The terms of multiple licenses assigned to a device will be

added up and automatically combined into one license. In the future, a newly

designed license dialog will be available for you to conveniently assign

compatible licenses from your license pool.



https://www.lancom-systems.com/products/firmware/lcos-release
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Wi-Fi 6(E) configuration at project
level
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LANCOM Management Cloud 1.00.141.0 / 06.09.2022

Wi-Fi 6E - The LMC is ready for the Wi-Fi VIP experience

Wi-Fi 6E uses the 6 GHz frequency band reserved exclusively for Wi-Fi and

plays out its advantages to the full, especially in high-density environments.

The LANCOM Management Cloud is perfectly prepared for this and provides a

6 GHz view in the Wi-Fi / LAN dashboard. Under Project specifications > SDN

> SD-WLAN > 6 GHz band, you can make configuration settings for the entire
project and customize them in the Wi-Fi settings at site and device level. With the
Wi-Fi 6E-capable access point LANCOM LX-6500, you also benefit from 6 GHz

Wi-Fi on the hardware side. Find out more on our Wi-Fi 6(E) technology page!
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Further improvements
- Support for LANCOM ISG-5000
- BPJM filter for LCOS
- Device name resolution in the archive log

-> Metric name resolution in the archive log

Bug fixes
- An error in the password repetition during user registration could prevent the
registration.
- Some minor adjustments in the sites overview dialog
-> Fixed a problem with updating the device table in new or empty projects when

adding new devices.



https://www.lancom-systems.com/products/wireless-lan/indoor-access-points/lancom-lx-6500
https://confluence.lcs.intern/www.lancom-systems.com/technology/wi-fi-6

60 Release Notes - LMC Software Release up to 1.00.180.0

LANCOM Management Cloud 1.00.140.0 / 16.08.2022

Sorting and filtering in tables

Do you manage large projects with a high number of devices and still want to have a
clear overview? Sorting and filtering location, user, and project tables helps you find
what you're looking for much faster. Click on the arrows in the table header to sort
alphabetically in ascending or descending order. You can activate the filter feature
by clicking on the filter icon and entering your search term. For example, you can
quickly identify the users of a particular access point in long Wi-Fi user tables under

AP name”.

Wi-Fi Users EA ¢
Name SSID Signal Client IP Client MAC AP name v Frequency Mode Throughput  Rx rate Txrate
.
6e8dd4bcb349 LANCOM-VISITOR 192.168.2.116 6e:8d:d4:bc:b3:49 Ic-e201_lc-cloud 5 GHz ac 826.65 kBit/s 433 MBit/s 433 MBit/s
Galaxy-S7-edge LANCOM-VISITOR 192.168.2.215 4c:66:41:59:b5:f8  Ic-e2 5 GHz ac 201.07 Bit/s 585 MBit/s 780 MBit/s
Galaxy-A5-2017 LANCOM-VISITOR 192.168.2.154 80:4e:70:49:cb:1c  lc-e201 | 2.4 GHz n 1.14 kBit/s 72 MBit/s 175 MBit/s
Pixel-4a LANCOM-VISITOR 44% 192.168.2.112 36:2c:a4:bS:ca:1a  Ic-e200_lc-cl 2.4 GHz n 0 Bit/s 117 MBit/s 144 MBit/s
S10-von-Rene LANCOM-VISITOR 192.168.2.139  be:b5:e9:f7:75:f5 5 GHz ac 62.08 kBit/s 234 MBit/s 351 MBit/s
Galaxy-S7 LANCOM-VISITOR 192.168.2.166  4c:66:41:4b:22:58 5GHz ac 49.6 Bit/s 45 MBit/s 526 MBit/s
Pixel-6 LANCOM-VISITOR 192.168.2.250  a6:1e:d0:ff:b1:3a  Ic-e128 Ic-cloud 5GHz ac 44.8 Bit/s 780 MBit/s 866 MBit/s
mchittka-1 LANCOM-VISITOR 192.168.2.179  80:38:fb:bc:49:54  Ic-e128_Ic-cloud 5GHz ac 124 Bit/s 39 MBit/s 234 MBit/s
< >
< 1 2 4 5 > 17-240f33
Sorting and filtering in tables

Further improvements
- The dialog for entering the location position has been revised.
- Numerous endpoints have been adjusted according to the current
Swagger OpenAPI specification. Please note that the endpoints marked as
,deprecated’ will be removed in one of the upcoming releases. You can see the

customizations in chapter 4 “History of incompatible APl changes”.

Bug fixes
- Corrected error handling when checking user input in the registration form
- Improved error handling when registering users without memberships
- When a new network is created, all switch ports are no longer incorrectly
selected for it.
- The configuration options of the HSVPN switch in the ,Networks' dialog have
been corrected.

- The Layer-7 Detection settings in the ,Networks’ dialog have been corrected.
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LANCOM Management Cloud 1.00.139.0 / 26.07.2022

Search function in the LMC

Find networks, devices, locations, and LMC functions even faster: With the new
search engine, you can search your entire project in a quick and easy way with
just a few clicks - or, if you prefer, even without any clicks at all. Just use the
maghnifier icon in the top navigation bar or alternatively the keyboard shortcut ‘ctrl
+ K’ (Windows) or ‘cmd + K’ (macOS). For your given search term, a language-
independent search is performed on project level. You can also narrow down the

results list with three selectable filters in advance. Try it out right away!

Search

Keyboard shortcuts

Search for sites (by name)

Search for devices (by name, device model, site or

Search function in the LMC

Further improvements
- The creation of an LMC organization is now also possible for partners outside
the DACH region directly via the myLANCOM portal.
- When exporting CSV time series on the dashboard, the times are now also
given in Central European Time in addition to the Unix time format.

- The Wi-Fi user table in the device overview can now be filtered and sorted.

Bug fixes

- The DHCP widget on the device page did not show any linking for network
names with special characters.

- The ,Create and Edit’ page of a network did not correctly visualize that saving
was prevented due to errors in the form.

- The ,Create and Edit’ page of a network did not allow changing the subnet size
per site.

- The ,Create and edit’ page of a network did not allow changing Layer-7

application detection settings.
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- The ,Create and Edit’ page of a network incorrectly allowed spaces when
specifying multiple VPN Central Sites.

- The documentation regarding the add-in editor has been extended to allow
the code suggestion window to be opened manually in the editor.

- In the settings dialog for subnets (networks at the site), there was incorrectly

the option to declare non-VPN networks as Central Site.

& LANCOM

SYSTEMS




63 Release Notes - LMC Software Release up to 1.00.180.0

LANCOM Management Cloud 1.00.138.0 / 05.07.2022

General improvements and bug fixes

Announcements
- When deleting a project, it is now explicitly pointed out that previously unused
device licenses in the project expire.
- To execute the action ,Device exchange’, the affected device must be offline.
This is now indicated to the customer by a message if he wants to execute the

action for a device that is still online.

Bug fixes

- Fixed an error when moving a project to an organization with an identically
named project.

- Login failed if two-factor authentication was enforced for the account that
was last accessed, but the user was not using two-factor authentication.

- Disabling SD-WAN no longer hides the network name in the site.

- An access point with LCOS LX could not take over a configuration from the
LMC.

- Correction of the interface configuration to the LL2M function.

- When importing locations from CSV, the gateway ID of the network is now

correctly taken over.
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LANCOM Management Cloud 1.00.137.0 / 14.06.2022

Application Steering of the LANCOM R&S®@Unified Firewalls

Increase the overall performance of your network by steering specific data traffic
(Application Steering): Applications classified as trusted for your network, such as
Microsoft 365, can be routed directly to the Internet via a Local Internet Breakout.
With just a few clicks, central Application Management configurations of the
LANCOM Management Cloud (LMC) are automated and securely applied to all sites.
Create your own rules under ‘Networks > Application Management > Steer traffic’
now also with ‘LCOS FX’ marked applications and extend the benefits of the Unified

Firewalls in combination with the LMC.

Q) LaNCOM

Networks

Owrview  Wifi  Swiches @ Sewrty @ Apslcoron Vorozemer: @ Comtenclter  Addine  Varisbles

Application Steering of
‘LCOS FX’' marked applications

Announcement
- The RSS feed is now available via a new subscription link:

www.lancom-systems.com/Imc-rss

Further improvements

- The maximum number of networks per project has been increased to 256.
Bug fixes

- Switching from the account overview to a project occasionally did not work.

- A predefined GoToMeeting security exemption update could not be cloned.
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LANCOM Management Cloud 1.00.136.0 / 24.05.2022

Cloud-managed hotspot vouchers

In the new hotspot portal of the LANCOM Management Cloud (LMC), you can create
any number of vouchers for Wi-Fi access in no time at all and set individual device
and time limits for them. You can access the hotspot portal when creating a cloud-

managed hotspot under ,Networks/Add network/Hotspot Network/Authentication/

Voucher’ or even more easily using the new LMC role ,Hotspot Operator’. With the

help of a simple user interface, for example, receptionists can also export vouchers
for their hotel guests quickly and easily in CSV or PDF format. Learn more about the

vouchers and their design customizations in this Knowledge Base article.

& Bcom “ 4

ent Clouc

Hotspot Portal

Hotspot Networks Your SSID Vouchers
Hotel hotspot Number of vouchers Devices per voucher
100 3 v

Hotspot Voucher

Your SSID Valid until including Usage duration (starting from first usage)

Creating hotspot vouchers © 2014 - 2022 LANCOM Systems GmbH Guided Tour Project Data protection notice | Terms of use | In

Announcement
- Before transferring a device with an active license to an organization, it must

first be deposited in the license pool.

Further improvements

- The help text for the auto-updater has been optimized.

Bug fixes

- Anissue with the breadcrumb navigation of project defaults has been fixed.

- In the Wi-Fi user table, the filter options for the frequency band have been
corrected.

- Added the missing translation for disabling the Internet connection.

- An error in the WAN dashboard when displaying the average values of the
VPN connections has been corrected.

- PoE information is now displayed for the GS-4554XP switches.

- For the stacking switches, the port default ,Auto’ (Auto Negotiation) is now

correctly displayed.
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- An error in sorting by IP addresses in the device list has been corrected.
- Optimizations in the evaluation of changes in add-ins regarding the display of

the configuration status.
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LANCOM Management Cloud 1.00.135.0 / 03.05.2022

Firmware updates and device replacement of LANCOM R&S®@Unified Fire-
walls via the LMC

LANCOM Management Cloud (LMC) and LANCOM R&S®Unified Firewalls grow
further together: From now on, you can manage firmware updates for your firewalls
as of LCOS FX 10.8 centrally via the LMC and conveniently keep an eye on the
firmware status in the device table. And there is even more: You can also easily
replace your firewalls, including the complete configuration. Simply select the
device to be replaced in the device table and enter the serial number of the

replacement device under Menu > Transfer — done!

Firmware update

10.8.4874 RU1 (recommended

Firmware update via LMC

Further improvements
- The endpoint GET /account/{accountld}/sites has been changed to streaming.
- Navigation to an assigned floor plan is now possible from the device overview

directly from the ,Position’ area.

Bug fixes
- In rare cases, a timeout did not redirect to the login page.
- Fixed a problem with CSV location import when adding new networks
afterwards
- Fixed a problem with a filter criterion in the device table
- When setting the serial number of a preconfiguration, the tooltip was partially

not closed.
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LANCOM Management Cloud 1.00.134.0 / 12.04.2022

Protection of minors according to German BPjM filter

With the recommended website filter of the German Federal Review Board (BPjM),
you can now protect children and adolescents even more reliably: For example,
schools or youth facilities benefit from a constantly updated list of blocked URLs
that are classified as harmful to minors in Germany. You can activate the BPjM filter
as an extension of the Content Filter for your LANCOM R&S°®Unified Firewalls with
Full License and LCOS FX 10.8 under Networks > Content Filter.

2 o — o ®

Networks

tarberter 1921680016 s v v

Owrview  waF  Swid hes @ secrty @ Appliation Management @ ContentFiter  Addins  Varia bles

Further improvements

- As of LCOS 10.60 Rel, a boot process and its cause are displayed in the LMC
device log for LCOS devices after a device has reestablished the connection
to the LMC.

- In the add-ins, the gateway IP addresses can be used at the location level via
the new variable ,context.location.gatewaylps'.

- In the add-ins the device serial number and MAC address are available via
the variables ,context.device.serialNumber’ and ,context.device.macAddress'.
Existing devices must reconnect to the LMC once, e.g. by rebooting, so that

this information is available.
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Bug fixes

- Inrare cases, a user was logged out before the set timeout.

- An error in retrieving deep links has been corrected.

- Setting the configuration status to ,outdated’ in connection with add-ins has
been optimized.

- A misbehavior in the environment of re-sorting stack units has been fixed. In
the affected cases, all units are now displayed again.

- Disabled DHCP server settings are now also correctly displayed as inactive in
the networks at the site.

- If no SD functions are activated in a project, the add-ins are not supported
and are no longer displayed.

- In the dialog for creating preconfigurations, form fields were sometimes not

updated.
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LANCOM Management Cloud 1.00.133.0 / 22.03.2022

LAG support for stackable switches

Setting up LAGs (Link Aggregation Groups) for stackable switches of the GS-4500
and XS series is easy with the LMC! LAGs are used to realize link aggregation and
load balancing: As soon as one active link fails, all other links of the group remain
active and share the load of the data traffic among each other. You can set this up

conveniently using the graphical interface in the device overview.

Further information is available in the tech paper LANCOM fail-safe stacking.

Unit1 Management Unit (LANCOM XS-6128QF)
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it2 Management Standby (LANCOM XS-6128QF)

1-Port12 v B

LAG setup for stackable switches

Announcement

- The URL for future firmware downloads will be changed to my.lancom-
systems.com on 24.03.2022 / 18:00 CET. Existing firewall entries must be
adapted or supplemented in advance.

- Prior to a device transfer to an organization, assigned licenses are stored in
the project as of one of the next releases. Commissioning licenses then lose
their validity when transferred to an organization. Projects are not affected by
this.

Further improvements
- An APl endpoint for device data (/accounts/{accountld}/devices) has been
optimized for large data sets (> 1500 filter results).

- API to change hotspot timeout for a specific MAC address
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Bug fixes

- The sorting of IP subnets in the network overview has been corrected.

- The change of the variable type is now applied without reloading the variable
page.

- If a variable of the ,Selection field’ type is used to assign a global add-in, the
associated values can now be selected correctly.

- Variables can only be assigned to a location if at least one network has been
assigned.

- Changing the user language now immediately updates the content of a
Content Filter rule.

- Error handling when creating exceptions in SD-SECURITY project defaults has
been improved.

- The RAM size for ISG routers is now displayed correctly.
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LANCOM Management Cloud 1.00.132.0 / 01.03.2022

Notification on active WAN backup connections

More transparency of your WAN connectivity: If a router switches to a backup
connection, you are directly notified via an alert. In the device table, you can see at
a glance whether and which routers are in backup status. This allows you to take
early action through targeted troubleshooting and possibly avoid high costs or the
consumption of a limited data contingent. Best of all: this feature is now enabled for

all LCOS-based routers under Project specifications > Alerts & Notifications.

LANCOM
o Tt

o ©

Devices Notifications

; WAN anomaly detected on 1793VAW
Fiterby v

pich

status A Names Model Serial Number Site - 1P Address

1793VAW (s

SDN)  4003632818100027

% Project specifications

e, which may arise costs based on the Interface
Management

1793vA 4005407118100350 2192002 0K(16.03.2022)

Rollout Assistant

Live Chat

Help

System Information

Further improvements
- To perform a rollout with firewall rules (app filter, AV, etc.) on LANCOM
R&S®Unified Firewalls with LCOS FX as of 10.6 Rel, the WAN object on the
desktop no longer necessarily has to be named "WAN".
- If variables with a user-defined type are used to assign global add-ins, the
type definition is now also used at this point. For example, if the variable is

defined as a selection box, this selection is available in the assignment dialog.

Bug fixes
- Corrected the display of the date and timestamp in the history graphs.
- Fixed a display error in the widget selection for dashboards.
- Responsive view (e.g. for mobile devices) has been corrected.
- Fixed a bug in the ‘close’ function of some dropdown elements (e.g. add-in
assignment).
- Fixed broken links in the ‘VPN site connections’ widget.
- A display error in the menu of floor plans of locations has been fixed.
-> Fixed a display error on the ‘Application Management’ and ‘Content Filter’ tabs.
- Fixed misleading log messages for users with access to multiple projects.

- A bug with the display of very long open warnings has been fixed.
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was not offered in certain situations.

- The add-in page is now displayed correctly when the page is reloaded in the
browser.

- A configuration rollout is now performed correctly even if associated central-
side devices are not up-to-date.

- The full screen mode of the Add-In editor now hides the side menu bar again.

- If the central site is to be deleted for a network that is assigned to further
sites, a corresponding note appears again.

- If an add-in is deleted, it can now be created again under the same name
without having to reload the page.

- The filtering in the add-in overview now behaves correctly.

- If VPN is disabled for a network, no DPS data is now collected for the VPN.

- Various display errors in the help texts have been corrected.

- If the still open detail configuration is edited further after a configuration

rollout, it is now possible to save it correctly again.
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LANCOM Management Cloud 1.00.131.0 / 08.02.2022

Cloud-managed switch stacking

Flexible, scalable, highly available: Stacking maximizes reliability and switch
capacity in your LAN. Via the management switch (“Management Unit”) and just
one device license, the entire preconfigured stack can be conveniently paired with
the LANCOM Management Cloud. The cloud independently detects which and how
many switches belong to the stack. Further management and monitoring of the
switch units can then be done in the device overview of the corresponding
switches. For professional network integration and configuration, a design quide is

also available in the help portal.

Ay LANCOM
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Further improvements

- LAG support is now also available for XS and GS-45xx switches.

- In the port templates for switches, 30- and 54-port models are now available
at the network level.

- If an LCOS device reports errors when executing addScriptLine commands
from add-ins, these are now displayed in the LMC device logs.

- If, when creating a DPS (Dynamic Path Selection) configuration, it is
determined that none of the specified WAN connections exist on the device,
the LMC aborts the configuration with a warning. This prevents the creation of
a non-functional LoadBalancer configuration.

- For new projects, the saving of local configuration changes on the devices in
the LMC is activated by default.

- Cloud-managed hotspot: configurable timeout

- Cloud-managed hotspot: Wallpapers and logos can be reset to default

settings.
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- With automatic password assignment by the LMC, the password policy check
on GS-3xxx series switches works again.

- If a device is not assigned a role at the site, the VLANSs are no longer created.

- Cloud-managed hotspot: A redirection issue has been fixed for devices with
iOS operating system.

- A display error in the maps of the device overview has been fixed.

& LANCOM

SYSTEMS




®

76

LANCOM

SYSTEMS

Release Notes - LMC Software Release up to 1.00.180.0

LANCOM Management Cloud 1.00.130.0 / 18.01.2022

Custom fields at organisational level

Organization administrators can now manage multiple projects more easily with
custom fields: Additional data can be added, edited, sorted, and filtered for each
project to keep workflows efficient as the number of projects grows. To do this, add
custom fields in the project overview under Project > Configure columns > Add new
column. Learn more about the user roles and rights system in the LANCOM

Management Cloud in this infopaper.

K Lancom

FE|

AAARAANR
5

Further improvements

- Omitted information from the switch overview has been added again.

- The Wi-Fi 6E view for the map view on the Wi-Fi/LAN dashboard has been
added.

- The contents of new DSC parameters are reloaded from the devices as
required, provided that the parameters were already present on the devices in
earlier versions.

- If changes are made in add-ins that are assigned to specific devices via an
assignment variable, only the assigned devices are set to ‘not up to date’.

- The robustness of WEBconfig and terminal tunneling via the LMC has been

optimized.
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Bug fixes

- Fixed the infinite spinner issue when logging in after resetting the password.

- A problem with saving a device image under ‘Devices / Position’ has been
fixed.

- Several bugs in the VPN dashboard have been fixed.

- Log messages for automatic site selection by transmitting the location
information have been added.

- The VPN site overview in the WAN/VPN dashboard can again be filtered and
sorted by remote site location.

- Pagination in the add-in overview has been corrected in connection with
filtering.

- The input set for switch port descriptions in the new switch overview has been
corrected (spaces and special characters).

- The display of the new switch overview has been corrected for browser
displays with zoom (port link and PoE display).

- The display and filtering of the new switch overview again takes into account
the names of connected devices learned via LLDP.

- The ‘untagged’ network can be set correctly again in the configuration for
single ports.

- If a new network is created, the switch ports assignment is displayed correctly
again.

- The setting of LMC DHCP options when site assignment is enabled has been

corrected.
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LANCOM Management Cloud 1.00.128.0 / 07.12.2021

Custom redirection of the Cloud-managed hotspot

Customize your Cloud-managed Wi-Fi hotspots: After successfully logging into the

Wi-Fi hotspot, an immediate redirection to a website of your choice is now possible.
To do this, simply add the desired URL directly when setting up the hotspot network

under Networks > Add Network > Hotspot Network > Advanced Settings.

Imprint & Footer v
Translations v
Advanced Settings A

Redirect user after login
Redirect URL

https:f/www.\ancom-systems.comy

WiFi4EU Support

Further improvements

- The Switch device overview page has been revised.

Bug fixes

- Performance optimization for user name queries

- The link to the device overview page from the floor plan has been corrected.

- When the DPS category of predefined targets changes, the page is updated
correctly.

- If a device is not assigned to a network, LLDP is not configured by the LMC.

- Various problems with the filter settings in the device overview have been
fixed.
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LANCOM Management Cloud 1.00.127.0 / 16.11.2021

Link to external syslog servers

More overview in larger projects: You can now define an external syslog server for
each project. After a configuration rollout, devices managed in the project report
relevant system information to this server for central processing and storage
(current exception: LANCOM R&S®Unified Firewalls). You activate the desired

syslog server via Project defaults > External services > Syslog.

'Q‘ LAncom LANCOM Systems~

Management Cloud Project

Dashboard Project specifications > External services > Syslog

NEeT Syslog

Sites Syslog mode

Devices Use device specific settings

Activate Syslog

Add-ins

Deactivate Syslog

Project specifications
Port (UDP)

Management

Loopback network (only needed for setting on gateways)

Bug fixes

- For sessions tunneled through the LMC to the Webconfig interface of devices,
the transport path for HTTP responses has been optimized. Files are now
transmitted to the browser in multiple smaller data packets. This solves the
timeout problem that can occur with browser requests when accessing a
device’s webconfig interface if devices are connected to the LMC via a slower
or heavily loaded WAN line and the transmission of a complete HTTP response
takes an untypically long time.

- In case of repeatedly failed login attempts, the login prompt was displayed
instead of the correct error message.

- A problem with linking the WebConfig of R&S®Unified Firewalls from the device

table has been fixed.
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LANCOM Management Cloud 1.00.126.0 / 25.10.2021

Anti-Virus for secure e-mail traffic

Even more cloud-managed Security: Thanks to advanced setting options in the
LANCOM Management Cloud, this enables the use of the LANCOM R&S°Unified
Firewalls’ Anti-Virus engine to scan e-mail traffic for malware. With the Anti-Virus
engine enabled, the LANCOM R&S°Unified Firewall automatically analyzes
unencrypted e-mail protocols (SMTP, IMAP, POP3). In addition, enabling SSL
Inspection ensures maximum security even for encrypted data. Under Networks >
Security you will find an overview of the current security settings of your gateways

as well as buttons for activating the Anti-Virus engine and SSL Inspection.

’Q\ !'ANFOM,_, LLLLLL LANCOM Systems~

ment Clo project

Dashboard Networks

Networks Overview Wi-Fi Switches @ security @ Application Management & Content Filter Add-ins Variables

Sites The following table gives an overview of the current security settings, depending on the type of device serving as gateway for the selected
network.

Potentially problematic settings will have a warning icon. Hover the mouse cursor over an entry to get more information on that setting.
Further information s available in the LANCOM Techpaper.

Devices

Add-ins HTTP/HTTPS Email Other traffic
Project specifications LCOSEH @ Application Management A A @ Application Management
@ Content Filter tFilte
Management = mm o @ Antivirus @ Anti-virus
HTTP/HTTPS Email Other traffic
LCoOS @ Application Management @ Application Management
M _ @ ContentFilter A
Rollout Assistant @ Allow traffic from this network to the Internet (LANCOM R&S®Unified Firewall)
LANCOM R&S®Unified Firewalls will block all traffic that is not explicitly allowed. By
Live Chat enabling this setting, a rule will be created that allows traffic to pass from this network

to the Internet, for example for email or home banking, Web access is automatically

allowed with active Content Filter
Help

System Information @K Anti-Virus (LANCOM R&S®Unified Firewall)
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Further Improvements
- Static IP Tolerance: In the Project Preferences > Base Configuration area, it is
possible to define that a static IP configuration on access points and switches
within this project is maintained by the LMC.
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Bug fixes

- The internal performance of the devicetunnel service for webconfig sessions
tunneled through the LMC has been optimized.

- Add-ins can no longer be deleted by project members.

- The switch for disabling Wi-Fi frequencies works correctly again for LCOS LX
access points.

- A display problem when removing access points from floor plans has been
fixed.

- Missing widgets for WAN throughput are displayed again.

- Fixed sporadic hiding of widgets in the device overview.
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LANCOM Management Cloud 1.00.125.0 / 05.10.2021

Cloud-managed Firewalls & SD-WAN

Use LANCOM R&S®Unified Firewalls as fully-fledged SD-WAN gateways: The
LANCOM Management Cloud takes over the time-consuming, manual firewall
configuration as well as the automatic setup of VPN connections between all sites
(Auto-VPN). Configurations of the content filter, anti-virus functionality, SSL
inspection, and application management are performed centrally and applied
automatically to all desired sites. Discover the new possibilities on our Cloud-

managed Security topic web page.

e .

CLOUD-MAN.

= bl

Further Improvements

- The configuration of a device can now be rolled out directly via the
configuration status display in the device list.

- Further device-specific functions such as configuration and firmware rollout
can be called up directly from the device view.

- In the device overview, the assigned location is displayed as a link.

- The dashboard widget for displaying additional VPN connections can now be
filtered.

Bug fixes
- If a device is removed from a site, it is now also correctly deleted from the
floor plan.
- The absolute expiration time for RADIUS user entries can now be set via the

detailed configuration.
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LANCOM Management Cloud 1.00.124.0 / 14.09.2021

Vimium support for barrier-free keyboard control

The LANCOM Management Cloud supports the browser extension Vimium for
Google Chrome, which enables keyboard control of web pages. Vimium allows
experienced users a significantly faster navigation and control, fits seamlessly

into the workflow, especially for power users, and thus offers enormous time
savings when operating the LMC. In terms of barrier freedom, operation without a
mouse is also made possible. Learn more about setting up and using Vimium in this

Knowledge Base article.

&Vimium

Further Improvements

- Opening the WEBconfig of a device can now also be done via the actions in
the device list, if the device supports this feature.

- Opening the WEBconfig and the terminal of a device as well as the device
reboot can now also be done directly in the device detail view, provided that
the device supports these features. The actions can be found on the right side
of the screen via a now displayed ‘3-dot button’. Accordingly, the previous tab
‘WEBconfig remote access’ is no longer available in the device detail view.

- The LMC disables all insecure configuration protocols on the managed
devices. This feature can now be optionally disabled.

- The error messages in case of a problem with the AFU (Automatic Firmware
Updater) now provide more details.

-> Long variable names in the add-ins assignment are displayed by ‘mouse over".

Bug fixes
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- LCOS LX access points are now correctly presented with the Access Point and
HotSpot Gateway functions.

- If an LCOS access point is operated as a cloud-managed hotspot, the
management network (INTRANET) is now used as the sender for LMC and
RADIUS communication.

- Load balancers for DPS are now correctly created by the LMC even if an entry
with the same name already exists in the device.

- The warning when assigning networks with the same VLAN tag to a site is now
also displayed when all networks are selected.

- After reloading the LMC in the browser by pressing F5, the language is no
longer set to German.

- Device names for switches and unified firewalls can be set correctly again.

- LLDP can be configured correctly again at the device level.

- Fixed a bug with the display of the DPS graph.

- Fixed the display of incorrect gateways and networks for site connections in
the VPN dashboard.

- Correction of the configuration rollout for cloud-managed hotspots.

-> Fixed a white screen when switching between accounts.
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LANCOM Management Cloud 1.00.123.0 / 24.08.2021

Dynamic DNS Service for upstream provider routers

With the Dynamic DNS function, you simply assign a fixed, self-selected subdomain
(mycompany.dyndns-Imc.de) to the gateways used there in the site settings. This
practical function can now also be used on connections with an upstream provider
router. To do this, select the option “Externally detected public WAN IP” under Sites
> WAN Connections > IP Source, and the LANCOM gateway (from LCOS 10.50) uses
the usually dynamic WAN IP address of the provider router for the DNS update.

Q) LANCOM

Q st

s Devices

& Aaddins
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Help

© system information

Further Improvements
- The Notifications and Alerts page contains a variety of configuration
options. This section has been redesigned and the configurations for e-mail
notifications have been moved to a separate tab. The design of the new tab
corresponds to the ‘Webhooks’ tab in ‘Alerts and notifications’.
- The list of projects and organizations in the account overview is now sorted by

name.

Bug fixes
- Some areas that were previously not controllable by keyboard via the Vimium
plugin have been added.
- In the VPN dashboard, several errors in the display of VPN gateways have
been fixed.
- Fixed an error in the display of networks for site connections in the VPN
dashboard.
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LANCOM Management Cloud 1.00.122.0 / 03.08.2021

Secure Terminal Access in a separate browser window

Secure Terminal Access provides direct access to the command line of LANCOM
devices (CLI tunneling) — securely encrypted and directly from the LMC interface.
A new feature is that the terminal now opens in its own uncoupled browser window.
The user can continue working in the LMC window in parallel. In this way, several

terminal windows can be used in parallel, individually scaled and moved.

£ LANCOM-1781EF+ | LMC Secure Terminal - Google Chrome — O X

O iasgancini L

#
| LANCOM 1781EF+

| Ver. 10.50.0145Rel / 13.07.2021
| SN. 4004186293100103

| Copyright (c) LANCOM Systems

LANCOM-1781EF+, Connection No.: 003

root LANCOM-1781EF+:/

sy=sinfo

DEVICE: LANCOM 1781EF+

HW-RELEASE : C

SERIAL-NUMBER: 4004186293100103

MAC-ADDRESS : 0020572b8924

IP-ADDRESS: 0.0.0.0

TP-NETMASK : 0.0.0.0D

INTRANET-ADDRESS @ 0.0.0.0

INTRANETMASK : 0.0.0.0

VERSION: 10.50.0145Rel / 13.07.2021

VERSION-GIT: T4a05727d902a4f74805£f8cabb32e£054e77ebb

NAME: LANCOM-1781EF+

CONFIG-STATUS: 1000480;0;35b1071£4bfdbB342c6d7a0164eb0fb94495c118.10252027072021.734
FIRMWARE-STATUS : 0:;0.63;0.51;10.50.0145Rel.13072021.63;10.50.0138.01072021. 62

LOADER : 4.12.0001Rel

HW-MASK: 00000000000000000000000000000011 -

Further Improvements

- The LMC now supports the browser extension Vimium, which also enables

keyboard-only and barrier-free control of web pages.

- A firmware update can now be performed model-wide via the device
selection.

- The DynDNS status interface now displays an info if a device does not have a
license.

- DynDNS can now be configured in the LMC to automatically detect the WAN
IP address by an external service; this way the WAN IP address of an upstream
third-party gateway can also be detected (requires LCOS 10.50 Rel).

- Support for LCOS LX 5.34

- The signal color for successful admin logins has been adjusted from red to
orange.

- Notifications are not sent to unlicensed devices.

Bug fixes
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the browser.
- Fixed a problem with DynDNS and multiple WAN ports.
- The Secure Terminal Access content can now be exported as a text file, even
after the connection to the device is lost.
- Editing the address in the account properties no longer leads to a gray page.
- The timer for automatic logout is no longer displayed as “15 min’.
- Corrected display of the VPN connection duration if the connection is

established for more than one month
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LANCOM Management Cloud 1.00.121.0 / 13.07.2021

The LMC help portal - clearly arranged and just a one-click away

In the new portal, all helpful information for operating the LMC is easy to find and
centrally accessible: information such as basic documentation, tutorial videos,
knowledge base articles, FAQ, license information, and the latest features. For
this reason, help and system information have been split into two separate areas,

creating additional clarity. This makes the LMC even more user-friendly.

Help portal

e Basics Tutorial videos

B Resdt B v

LAMNCOM
e Knowledg

i 2
— s

Further Improvements
- The Wi-Fi channel width can now also be specified at project and site level.
- Firmware updates for individual devices can now be done directly via a link in

the device table.

Bug fixes
- If supported by access points, the channel widths of 80+80 and 160 MHz can
now also be selected in the Wi-Fi device settings.
- A user with the role ‘Project member’ could previously only open the

WEBconfig, but not the device terminal. Now both is possible.
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LANCOM Management Cloud 1.00.120.0 / 22.06.2021

Convenient development environment for add-ins

Using add-ins in the LANCOM Management Cloud is now much easier: The new
add-in editor offers context-based suggestions for code completion with existing
functions and OIDs. In addition, you benefit from practical support for code
formatting as well as for synchronizing variables used in the script and assigned to
the add-in. A full-screen view is now available for a better overview when working

with add-ins.

For more information please see the add-ins manual.

ins > Create Add-in

Further Improvements

- The sender of the LMC emails will be changed from ‘noreply@cloud.lancom.
de’ to ‘noreply@mailing.cloud.lancom.de’. The invitation, notification and
license summary emails will have a different sender address from now on.

- The firmware update dialog has been revised.

- If there are multiple problems when updating a device with an initial firmware,
the customer is now notified manually and can commission the device
manually.

- The webhook user data can now be signed with HMAC.

Bug fixes

- The defaults for variables in add-ins are used correctly again.

- For configurations created with the given default, the correct WLAN country
default is now set instead of the country ‘unknown’. In addition, the field is now
writable.

- A pagination error in the user table has been fixed.

- Performance optimization and reduction of requests when calling floor plans
in the dashboard

- Fixed the issue that a device could be partially disconnected from the cloud
after being added to and removed from a project.

- A problem with the use of commissioning licenses has been fixed.



https://www.lancom-systems.de/docs/lmc/scripting/add-ins/add-in-editor.html
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LANCOM Management Cloud 1.00.119.0 / 01.06.2021

Open Notification Interface

To be able to react early, administrators need to be notified immediately when a
network event occurs. Thanks to the Open Notification Interface, collected alerts
about various events can now be forwarded to any recipient service, such as Slack,
Jira or Splunk, that enables communication with the LMC based on Webhook
technology. This allows users to flexibly integrate notifications into their usual work

environment and also merge them with alerts from third-party systems.

f‘Q\ }HNCOM‘ i ranze LANCOM Systems > D € jane'D e

loud Project Project Adminis

Dashboard Project specifications - Alerts & Notifications
Networks Alerts & Notifications Open Notification Interface

Sites Awebhook triggers an HTTP POST to a URL for the selected alerts. A maximum of 5 webhooks can be added.

Devices

Project specifications

‘ Active

v X
Management
* Required fields
Name Alerts
Splunk Anomaly Detection
Device offline
*URL
Device config changed
hteps/fwebhooks.splunk com/asfg
Device config download failed
Device firmware update failed
Send test alert Device canfig rollout failed
Device config sync failed
Automatic firmware update failed
Automatic firmware update successful
New log downlo: ailable
- Slack Anomaly Detection  Device offline o
s 0
https://slack.com Device config changed  Device config download failed
& Rollout Assistant
.-. Live Chat
o Information area
£ 2014 - 2021 LANCO s GmbH Guided Tour Project Data protection notice | Terms of use mprint
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Further Improvements

- New LMC help portal is available.

- The former “Info area” has been split into “System information” and “Help”.

- The color coding of the networks is now also used in the network assignment
at the site level.

- The help chat has been revised.

- Automatic license assignment for expiring licenses is enabled by default for
new projects.

- The performance of the device list has been optimized.

Bug fixes

- If the WLAN country setting for a WLAN access point is set to “unknown”, it is
set to the device default.

- Variables used as conditions for globally assigned add-ins can now be deleted
again correctly at the device level.

- A WLAN base data rate set to “automatic” no longer causes a configuration
rollout error for individual devices.

- The configuration of VLANs on XS-6128QF switches has been corrected.

- The column header for the channel of WLAN networks has been corrected.

- Error in displaying data in the device overview after manual page reload has
been fixed.

- The “WLAN transmit quality” widget now shows the correct values again.

- The widget selection in the dashboard now shows through a scroll bar that
there are more items to choose from.

- Fixed a bug in the Dynamic Path Selection widget when there are more than

four WAN connections in the statistics.

& LANCOM
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LANCOM Management Cloud 1.00.118.0 / 11.05.2021

Extended Wi-Fi settings

Even more control and time savings in your Wi-Fi projects! With the extended
settings options, you can define project-wide, site-specific, and device-specific
Wi-Fi configurations such as frequency bands to be used, channel allocation, or
channel width with just a few clicks. The settings in the project defaults are
conveniently inherited by the site settings, which in turn are inherited by the

individual devices. Start right away under Project specifications > SDN > SD-WLAN.
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Further Improvements
- The hotspot function based on a hotspot gateway, which is being phased out,
was reactivated in response to numerous customer requests.
- Improvement of the Add-In editor (syntax highlighting, auto completion,
general IDE functions) as well as synchronization of Add-In context variables
- The configuration of Dynamic Path Selection (DPS) has been extended by the
‘Session Switchover’ function and is available with LCOS 10.50.

Bug fixes
- The configuration converter for IEEE 802.1X has been corrected.
- If a fixed channel is assigned to a Wi-Fi device, other Wi-Fi settings are now
correctly inherited from the parent layers.
- The visibility of the user-defined columns was not permanent.

- A display error of the tooltips in the dashboard has been corrected.




93 Release Notes - LMC Software Release up to 1.00.180.0

- The Unified Firewalls graphs on blocked content now show the difference
values per time range instead of the absolute counters.

- The widget selection in the dashboard now shows a scrollbar in all supported
browsers.

- Fixed a misrepresentation when there are more than 4 WAN connections in
the Dynamic Path Selection graph.

- Improved signal strength formatting for Wi-Fi clients.
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LANCOM Management Cloud 1.00.117.0 / 20.04.2021

Automatic license assignment

The LANCOM Management Cloud automatically carries out the especially in

large projects time-consuming relicensing for you three weeks before the

devices’ licenses expire. To do this, activate automatic license assignment in the
Project settings > Basic > Automatic license assignment area and select whether
relicensing should be carried out using licenses with the shortest or longest term. If
there are no compatible licenses in the license pool, you will be notified directly and

can add additional license keys.

Activation of the automatic license
assignment in the Project specifi- G Lo
cations > Basic area © iormaton area

Further Improvements

- WEBconfig access from the LMC to an LCOS device is possible in combination
from LCOS firmware 10.42 RU3. Access takes place in the device detail view
via the ‘WEBconfig remote access’ tab.

- WEBconfig access to a Unified Firewall can also be found under the
‘WEBconfig remote access’ tab, and no longer under ‘Detailed configuration’.

- The target projects when transferring devices to other projects (or to the
parent organization) are now sorted by name.

- Optimization of the category display of device actions in the device table

Bug fixes
- Fixed a problem with saving the main device password for the ‘Uniform’
method.
- The counter for out-of-date devices on the Security and Compliance
dashboard has been corrected.
- Fixed anissue in the dashboard with linking devices with active alarms.

-> Fixed a problem with saving long device descriptions.
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LANCOM Management Cloud 1.00.116.0 / 30.03.2021

Add-ins — for tailor-made networks

Use the Add-ins to customize the configuration data of all devices managed in
the LMC or make versatile detail modifications to existing standard concepts for
SD-WAN, SD-LAN, SD-WLAN and SD-Security.

Activation: Project specifications > Basic > Configuration > Use Add-ins

Add-in Management: Add-ins (new one in the menu bar) > Create new Add-in opens
the integrated script editor.

Requirements: Knowledge of Java scripting and LANCOM operating systems
Additional materials: Information area > Further reading > Add-in Scripting

Handbook (incl. numerous practical examples)

Q) LANCOM
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Further Improvements

- Devices with pending configuration changes are permanently in view via an
info element and can be called up in a filtered manner via a direct link.

- The Add-in Editor can be switched to full screen mode.

- The ‘Basic’ section of the ‘Project specifications’ has been revised.

- Activation of the configuration test mode has been moved to the ‘Device
startup’ section.

- In the firmware update dialog, there is now an option to exclude already
selected devices from the update.

- The stability of the WEBconfig tunneling service has been optimized.

-> Optimizations in DPS rule generation

Bug fixes

- If a router is not assigned to a site or is not selected as a gateway, the
configuration no longer contains DPS relics.

- The configuration converter for changes to the IEEE 802.1X authenticator table
in LCOS 10.42 has been corrected.

- The license category of the devices LANCOM 1926VAG & 1926VAG-4G has
been corrected.

- A problem with uploading floor plans with a file size larger than 1MB has been
fixed.

- The causeless triggering of alarms for disabled Wi-Fi interfaces has been
fixed.

- Corrected memory display for some switch models
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LANCOM Management Cloud 1.00.115.0 / 09.03.2021

SD-WAN of the highest quality with Dynamic Path Selection

At sites with multiple WAN connections, Dynamic Path Selection ensures that
business-critical applications, for example, are always routed over the highest-
quality line. The feature continuously monitors your WAN links for load, packet loss,
latency, or jitter, and dynamically decides the optimal path for specific applications
based on the current link quality. Enable best SD-WAN quality in the ‘Project

Preferences > SDN > SD-WAN > Dynamic Path Selection’ section.

Q) LANCOW " QUQs WW.DPS ™ Py

Dynamic Path Selection -
Activation

Dynamic Path Selection can be enabled by checking a box. Policies, categories, and
definitions for common applications and protocols are already predefined in the DPS
configuration. This means that Dynamic Path Selection is applied immediately after
activation and rollout of the devices. Additional applications can also be assigned

quality criteria and individual settings can be made.
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Q) LANCOM QM-Qs WW.DPS ~ 4 e

Cloud Round T Time (ms) U Load ()

Dynamic Path Selection -
Monitoring Widget

The monitoring widget provides high transparency about the overall quality as well
as the quality of individual lines. A graphical interface allows to historically track the

connection quality and the preferred lines for specific applications.

Further improvements

- Warning dialog with control query when selecting a different VPN Central Site
location

- Individual notification / alerting per device

- The action list of the device table has been divided into categories for a better
overview.

- In case of a failed firmware update, the firmware target version is now stored
in the log file.

- The maximum image size of floor plans has been increased to 2 MB. The
upload of *.jpg and *.png image files is allowed.

- Configuration rollouts are now only possible for devices with valid licenses.

Bug fixes

- When activating the initial configuration rollout without test mode, the test
mode remained inactive until the device reconnected to the LMC. Test mode is
now only disabled for the first automatically initiated configuration rollout after
commissioning.

- Fixed a problem in the confirmation dialog when removing devices from the
organization.

- When working in the compact view, it could happen that the device selection
changed to the first filtered device.

- Error in the configuration of the WIFI4EU

- Minor cosmetic fixes on the hotspot configuration page
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LANCOM Management Cloud 1.00.114.0 / 16.02.2021

Full SD-WAN power: HSVPN and Load Balancing

LANCOM High Scalability VPN (HSVPN) ensures maximum scalability and efficiency
for your SD-WAN architectures! Numerous VPN connections is combined in just
one data tunnel, but without sacrificing the strict separation of routing contexts and
the security of a modern IPSec VPN. You can now enable this in the area Project
specifications > SDN > SD-WAN.

Furthermore, if multiple WAN connections are defined for a site, they will now
automatically operate in active/active mode (Load Balancing), thereby increasing

the total available bandwidth.

DU, B ®© o
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Further improvements
- Support for WIFI4EU
-> The ‘Device Licenses’ widget in the ‘Security & Compliance’ dashboard now

displays the number of all unlicensed devices.

Bug fixes

- A problem with missing firmwares in the device commissioning defaults has
been fixed.

- Missing log entries when creating and deleting preconfigurations have been
added.

- Fixed an error where the configuration could not be written to some device
types due to WLC-TUNNEL-AUTOWDS settings in the /Setup/LAN-Bridge/
Port-Data’ table.

- WAN connections whose names start with a number can now be included in
the configuration of ‘'WAN Connections and Load Balancing’.

- Changes to inactive networks no longer cause associated devices to be set to
‘not up to date’.

- Changes to assigned add-ins now cause associated devices to be set to ‘not
up to date’.

- If SD-WAN is disabled and device assignment based on IP addresses is
enabled in the project, newly created networks can be correctly assigned to
sites.

- Subsequent changes to the name of the WAN connection at DynDNS will no

longer cause DynDNS to stop working.
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LANCOM Management Cloud 1.00.113.0 / 28.01.2021

Cloud-managed Hotspot

Create a simple Wi-Fi hotspot with a few clicks - directly from the LMC. No
additional gateway or WLAN controller with LANCOM Public Spot Option is required.
Intuitive menus provide you with the opportunity to customize your hotspot
welcome screen with your logo and corporate colors and integrate important
information such as imprint and usage guidelines for your hotspot users. Afterwards
you can assign the new hotspot to the respective location and it will be available to

your visitors.

Bl Network Settings

Default Language

Backgr

Free Wifi

Internet Access

LANCOM

Further improvements
- The firmware type (Rel, RC, ...) is now displayed in the firmware update dialog.
- Stabilization of the rollout process with initial device firmware using retries
- Hotspot users are authenticated for 24 hours.

- The list of authenticated clients is stored for 5 days.

Bug fixes
- Fixed an issue related to closing notifications in case of offline

acknowledgements.
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LANCOM Management Cloud 1.00.111.0 / 15.12.2020

Dynamic DNS Service for the Public Cloud (Beta)

The LANCOM Management Cloud becomes a DynDNS provider! Simply assign

a fixed, self-selected subdomain (mycompany.dyndns-Imc.de) to the gateways
implemented there in the sites settings. This subdomain can then be stored in VPN
remote stations such as the LANCOM Advanced VPN Client. This way, gateways
(from LCOS 10.42 RC3) with dynamic WAN IP addresses remain accessible at all
times via this domain name.

This feature is exclusively available in the Public LMC.

’(}‘ LANCOM LCS-PMK~
Management Clout Project
@  Dashboard Sites > Site : Wiirselen
Netinoris Overview Networks WAN connections Internet Security WicFi Horspot Devices Floor plan
Sites
* Name of WAN connection on device
Devices INTERNET
Project specifications
@ Use connection for Overlay networks [VPN)
Matiasement @ Use connection for local Internet breakout
@ uscDynamicDNs @
* Dynamic DNS subdomain
wuerselen-gateway dyndns-Imec.de
Comment
LCS-PMK~
Project
@  Dashboard Sites > Site : Wirselen
=*  Networks Overview Networks WAN connections Wi-Fi Hotspot Devices Floor plan
o Sites Use site based settings v
dh  Devices
3= Praject specifications
Name = Usage Dynamic DNS
f# Management
INTERNET Overlay networks (VPN), Local Internet breakout wuerselen-gateway.dyndns-Imc.de
< >
Dynamic DNS
wuerselen-gateway.dyndns-Imc.de = B
Device LANCOM-ROUTER |8
&  Rollout Assistant 1Pv4 80.158.67.40
Lastupdate  11.12.202015:09
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- The Rollout Assistant can be accessed via the ‘Add device’ function in the
device table.

- The device table has been optimized for displaying many devices on slower
systems.

- Cloud-managed hotspot support (beta) available for devices running LCOS
10.42 RC3 or later

Bug fixes
- The user profile image can be changed again.
- A problem with the display of many devices in the firmware download dialog

has been fixed.
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LANCOM Management Cloud 1.00.110.0 / 24.11.2020

New user role ‘Technical Administrator’

In network infrastructures with several administrators, differentiating between
rights for technical and organizational tasks is necessary to implement compliance
requirements. An LMC user with the new role ‘Technical Administrator’ can
configure location, network, and device details. In contrast to the ‘Project
Administrator’, however, the Technical Administrator is not allowed to manage or

invite new users and cannot modify project information.

Invite new user

E-mail

jane.doe@systemhouse.com

‘ Active

Authaorities

Project Administrator
s allowed to manage projects, users and devices. Has unrestricted access to project infarmation

@ T g
UD echnical Administrator
s allowed to manage sites, networks and devices. Project information is read-only, and managing users is

Project member
s authorized to manage and monitor the project's devices. Has only read access to project information.
This user is allowed to add devices and read device information.

M Rollout Assistant App to simplify device claiming in this project.

orized to view but not to edit project- and device-related information

Further improvements

- If the Add-Ins are activated in the project, user-defined variables with a
definable input set can now be created.

- If command line calls (addScriptLine) are used in the add-ins, the LMC now
displays possible error messages of the configured devices in the log.

- The tables of license keys or pools are now sortable.

- The page size setting of the device table is now saved.

- E-mail addresses of users are now changeable.

- In e-mails the English text is now displayed first.
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Bug fixes

- When removing the assigned schedule on an SSID, affected Wi-Fi devices are
now correctly marked as not current

- The configuration options of the RADIUS server definition were corrected.

- If a display name is assigned to a variable that is created as a selection list in
the Add-In area, the selection list is displayed correctly again.

- If a variable is marked as password, the display name is now correctly
resolved in the once executed Add-Ins.

- If several similarly tagged networks are assigned to the same location, a
warning message is generated.

- Send and receive direction of the data for the top users in the dashboard are
now shown from the client’s perspective.

- Added missing throughput graphs for the ports.

- Removed suggestions for completing entries in explicit confirmation dialogs.

- Fixed a problem with the color indicator for the firmware status in the device
table.

- Fixed display errors with Firefox on the device overview page of switches
when editing port properties.

- For the Wi-Fi user name, the name transmitted by the RADIUS server is now
displayed preferentially.

- The access performance to the web interface as well as to the terminal
of the devices from the LMC was improved, a temporary instability of the

corresponding service was fixed.
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LANCOM Management Cloud 1.00.109.0 / 03.11.2020

Easy generation of new VPN passwords

If the VPN keys (IPSec PSK) of a VPN connection could be compromised — whether it
is due to an administrator leaving the company or a VPN gateway being serviced — it
is advisable to change these VPN passwords. The LANCOM Management Cloud
allows VPN passwords of individual sites to be conveniently changed with just a few
clicks: In the ‘Sites’ section you simply mark the affected sites, trigger the generation

of new VPN passwords and then roll out the configurations of the gateways involved.

Change VPN passwords

Are you sure you want to change the VPN passwords for 1 site(s)?

The VPN passwords are changed for the connections of the selected sites on the branch site and the corresponding central site.

To apply the changed passwords to the devices, the configuration must be rolled out again afterwards.

Enter OK to confirm the action

Cancel Change

Further improvements
- In the device and location table, only entries visible to the user can now be

selected.

Bug fixes

- A problem with assigning new devices to a location has been fixed.
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LANCOM Management Cloud 1.00.108.0 / 12.10.2020

Fully automatic device commissioning

The multiple zero-touch / auto-config features of the LMC for automatic
commissioning of cloud-managed devices are now extended by the possibility

of early detailed configuration without the physical presence of the device. The
advantage: The devices only need to be connected at the operating site and are
immediately ready for operation! Under ,Devices > Add Device” you can create
~preconfigurations”. You can assign the serial number directly in the device table.

Then add the device as usual using the activation code or PIN.

Step-by-step instructions for the feature “Fully automatic device commissioning
- Switch to the device overview.
- Press the “Add Device” button and select the menu item “Create
Preconfiguration”.
- Follow the steps and name the device, select the device model, make a

selection regarding the target firmware and define a location if necessary.

’G‘ LANCOM. » = LANCOM Systems~

@  Dashboard Jevices > Preconfigure device
Networks

Sites

Devices
* Required filds
Add ins

*Name

Project specifications

Management

* Model

Q) LANCOM 1780EW-4G+ v

*Targesfirmware @

Q 10.34.0162RUT ~

Software-Options
VPN (25 Verbindungen)
Public-Spot

Dynamic VPN

AllP

Content-Filter

Public Spot PMS Accounting plus

&> Rollout Assistant

W Live Chat

Cancel

@ informationarea

- Then press the “Create” button and the preconfiguration is created.
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- Once you have the device physically available,

- please click in the line of the previously created pre-configuration in the
column ‘Serial number’.

- An editable field opens.

- Enter the serial number of the physical existing device in this field.

- Now click on the check mark next to this field and accept the entry.

= A LUICa <
Devices =
Activation codes Filter by ¥ ¢ m
Statu A - Name Model Serial Number
179 v X
- 4004289418101188
v 4004167418100005
00f 13 selected
< 2 3 > 5/page “~
Guided Tour Projel Data protection ofuse | Impr

-> Now create a new Preclaiming entry via “Add Device > With Serial Number and
PIN".

Add new device

Serial number i I
L] .
Qlllt @

LANCOM LK-862

123456 R

Assign a site to use its softw.

Na cite
o site -

- The process is now complete.
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As soon as the power supply and Internet connection of the device are established
at the later location, it automatically connects to the LMC and receives the settings

of the preconfiguration.

Bug fixes

- Anomaly detection error that caused blocked 5 GHz channels to be reported
unreliably was fixed.

- An error causing VPN connections to be displayed twice in the dashboard was
fixed.

- Secure Terminal Access for devices sporadically stopped working after a Ul
auto logout, problem was fixed.

- The handling of the password policy in the details configuration of GS-3xxx
switches was corrected.

- On LCOS LX access points a time unlimited SSID can now be configured even
if the default ALWAYS schedule does not exist in the device.

- Optimization in handling DHCP ranges during CSV import (import failed for
certain subnet constellations).

-> Added error message when creating nets with already existing “internal
configuration name”.

-> Correction of the configuration conversion when switching to LCOS 10.42 in

the 802.1X settings environment.
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LANCOM Management Cloud 1.00.107.0 / 22.09.2020

Automatic firmware assignment

With this feature, you can control the automatic assignment of a preferred firmware
version during the initial setup of different devices. If you connect a device to the
LANCOM Management Cloud (LMC), the firmware corresponding to the
specification is automatically rolled out to this device. In this way, for example, all
devices in a project can be adapted to a uniform software version that corresponds

to the project specifications, regardless of the factory delivery status.

'Q\ tANC.l?lM ; o L‘A\.[O‘v‘ Systems™ f

Dashboard Project specifications > Device startup

e Use default configuration for
Access Points

Sites Routers
Switches

Devices

Initial device firmware + Add specificatior

Project specifications

Management

er delivery
re. Please note

Rollout Assistant.

Live Chat

configuration is used.

Information area

> | Terms of use | Imprir

Further improvements

- Additional confirmation is now required for critical delete operations for
multiple entries.

- The limit for CSV imports has been increased to 1,000 entries.

- The LMC now offers the possibility of conveniently renewing VPN passwords
manually per site.

- In the application management, IP address targets can now be created
without restriction to specific ports.

- In addition to the technical variable name, the add-in variables can be given a

more readable plain text name for the user dialogs.

Bug fixes

- A problem that prevented CSV imports in certain situations has been fixed.
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LANCOM Management Cloud 1.00.106.0 / 01.09.2020

Wi-Fi scheduling

The ‘Wi-Fi scheduling’ function enables the time-controlled activation and
deactivation of SSIDs in the wireless network. Ideal for wireless networks that
should only be available at certain times, such as hotspots or Wi-Fi in educational
institutions. You can individually determine the times and duration of Internet
availability. The scheduling specifications are created under ‘Project Specifications

/ Time schedules’.

(o Jrusal o [

I

Dashboard Project specifications > Time schedules

Networks

Select time schedule

Sites

Devices

Addins WORKING-TIME Delete time schedule

Priess spari O 0041102 13 1004 00506 U107 (008 U9 (1014 1112 11143 1111411115 11116 11117 11118111 191112011121 111 2211123

Management Mon ° ° B ©
Tue y -]

o7 17:55

Ved ° S O B O
Th 0 O , ©
Fe O ° B O
Sat L+
Sun ©

S5ID active

WORKING-TIME ~

Go to selected time schedule

24 GHz and 5 GHz v
Authentication

502.11i (WPA)-PSK v
WPA version

WPA2 v

Further improvements




112 Release Notes - LMC Software Release up to 1.00.180.0

to implement compliance requirements in the enterprise environment, where
technical and organizational rights should be separated.

- If a device is in up-to-date configuration state before an update with a major
release, a rollout to affected devices is now automatically performed after

conversion to the new configuration.

Bug fixes
- In the device detail view, the selected tab is now retained when selecting
another device.
- Warnings are now displayed in the floor plans.
- In the context of exceeding allowed claiming failures, a problem with the
display of the lockout time has been fixed.
- LEPS can be switched on correctly in the detail configuration for LCOS LX

devices.
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LANCOM Management Cloud 1.00.105.0 / 11.08.2020

Offline Acknowledgement - New device status for an improved overview
If devices are known to be offline for a long time, or if they are intended to be offline
for a longer period of time, or if work is already in progress on troubleshooting,
simply assign them an ‘offline acknowledgement’ from now on, which enables
clearer incident management. You can still identify all devices that are offline
unplanned by the red filled out display, known faults are only outlined in red. The
‘offline acknowledgement’ is automatically removed as soon as the device is back

online; devices marked as known are not included in the offline statistics of the

dashboards.
Devices =
Activation codes Filter by v c v
Configuration roll out
Status Name IP Address Firm Firmware Update
g R e A Start secure terminal
Offline Device-9005504816051743 72.121.203.33
Assign preconfiguration
Offine | Device-9005504816033641 172.71.245.10:
Add offline acknowledgment
Reboot device
[ oriine SRR L 7
Transfer device
D )
[ Offline | y ? : Remove device

Replace device

Further improvements

- Monitoring in the LMC for switches of the XS series

- WEBconfig access from the LMC to the switches of the XS series, e.g.
XS-5110F (from firmware 5.00.0053)

- Terminal access from the LMC to the switches of the XS series, e.g. XS-5110F
(from firmware 5.00.0053)

- The technical administrator can now configure two-factor authentication for a
project.
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LANCOM Management Cloud 1.00.29.2.0.0 / 30.06.2020

Audit logs

Changes in the LMC are now logged in a standardised way. These log messages
comply with the requirements of PCI conformity and thus create a complete,
non-manipulable tracing of events by containing all information about who made
which change and at what time. This happens in accordance with data privacy
standards. Only project administrators receive the complete information and can
download it once a month as a new log archive on the ‘Log Download’ tab. The logs

remain stored for one year before being deleted.

Properties  Users  License Log Download

john.doe

Create new network

Further improvements
- Reset of the two-factor authentication without deactivation
Previously, if the second factor was lost, the two-factor authentication had
to be deactivated and set up again using the ‘Forgot password’ dialog. If only
the second factor was lost, it can now be reinstated via the ‘Forgot password’

dialog without having to deactivate the two-factor authentication.

Bug fixes

- Problems with the live chat when loading external scripts have been fixed.
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LANCOM Management Cloud 1.00.29.1.1.0 / 09.06.2020

WLAN Anomaly Detection

Best Wi-Fi at all times—that is what users expect! However, WLAN is a complex

transmission medium and has to deal with many potential sources of interference

such as overcrowded channels, foreign, interfering WLANSs or other interfering

frequencies or disturbances caused by structural surroundings. Therefore, for the

best Wi-Fi experience, a fast and targeted troubleshooting is essential, which is

guaranteed by the new Wi-Fi anomaly detection.

To reach this goal, the LANCOM Management Cloud (LMC) evaluates data from the

managed WLAN devices using various “metrics” and compares it with previously

defined threshold values. As soon as this threshold value is repeatedly exceeded in

a certain interval, the affected device is marked accordingly in the LMC and the

administrator receives an alert.

Notifications

Anomaly detected on lc-e386_lc-cloud

An alert was triggered for the following metrics

Channel Load (5 GHz) has exceeded the threshold

Metric Current threshold

Channel Load 5 GHz: 60 %

Show detail Check threshold settings Today at 03:01
RAnomaly detected on lc-e197 _lc-cloud Jay v
An alert was triggered for the following metrics:
Clie Channel Load (2.4 GHz) has exceeded the threshold
f8:f Id setting Yesterday at 12:31
00:
Sc
f4:¢2:48:2b:10:c8 11.35 MByte 10.07 MByte 1.28 MByte
[7941 20:54:fa:38:63:dd 5.16 MByte 4.82 MByte 344.73 kByte
14d2 c0:b5:d7:a8:96:29 3.93 MByte 3.15 MByte 794.92 kByte
Alert v Status Name Model
-~ c-e386_|c-cloud LN-630acn dual Wireless
Alert triggered: Today at 03:01

Current value

5 GHz: 65 %
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- CPU resource allocation for device tunnel service (CLI and WEBconfig
tunneling) has been reduced to 1/4 by default.

- The logs of the last 31 days can now be downloaded.

- Dialogues for deleting devices and locations are displayed as a warning.

- The e-mail address of the user performing the import process is now
displayed in case of errors.

-> New user role in the LMC: Technical Administrator

Bug fixes

- Fixed a problem with the port view for GS-3528XP switches.

- The list of activation codes in the LMC did not display the selected number of
activation codes.

- The correct number is not displayed when displaying activation codes.

- Fixed inconsistencies in Ul behavior:

- Sidebar reopens after reload

- The maintenance banner reappears after closing it

- Content does not grow with compressed sidebar

- items per page dropdown issues

- When filtering and sorting locations, the selection of locations in the table was
not removed.

- The cloud enables LMC-specific DHCP options even if the project only
enables location assignment based on location information provided by the

device.
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LANCOM Management Cloud 1.00.28.0.0.0 / 19.05.2020

Device replacement & pre-configuration

Device replacement has never been easier: With this new feature, you can transfer
the complete configuration from an existing device to a new device of the same
model with just a few clicks. Simply select the device to be exchanged and enter the
serial number of the replacement device—done!

In addition, you now have the possibility to completely prepare a configuration for
numerous LCOS devices—even before the device is connected to the LMC. Ideal for

preparing your infrastructure for the least amount of effort during commissioning.

Replace device X

(T ram ranlars th anpiem vtk 3 Aevrira nf th B s W aTa e Tha ~ranfioiiratinn andA o
You can replace the device with a device of the same model. The configuration and a

settings are transferred to the new d

MName of the device to be replaced
1781EF+
Serial number of the replacement device

4000000000000000

Further improvements
- Logs are now archived monthly as CSV files.

- New API for the user data storage service

Bug fixes

- The device images for the GS-3528 series are now correct.

- The incorrect display of the blocking time in case of too many incorrect
claiming attempts has been corrected.

- The ‘Device Warranty’ widget has been removed from the ‘Security &
Compliance’ dashboard. The default layout of the dashboard will be adjusted
accordingly.

- When copying the device password from the device overview, no space is
appended.

- The setting of Wi-Fi channels via the floor plans was corrected.
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LANCOM Management Cloud 1.00.26.2.2.0 / 27.04.2020

Redesigned management & device log overviews

The logging of all events in the LMC is now even more comfortable and clearer.
Keep the overview at all times thanks to the clear layout. This applies equally to the
events of your network management and to the logs at device level.

All events are sorted chronologically by date and time, starting from the most
recent event in reverse order and going back up to one year in the past. If you are
interested in a previous event, you can jump directly to the corresponding time at

any time using the date search field.

For each line, information such as the date and time, a short summary of the event
and the name of the user who performed the event are available. By clicking on the
checkbox, additional events of individual devices in the network can be displayed.
Information relating to locations, devices or an action in the “Notification settings”
area is displayed as hyperlinks. This allows direct navigation to the named units.
The structure of the event log for the individual network components is similar to
the management log view. In the device logs, either only warnings and errors can
be displayed or the entries of the log level “Info” can be displayed additionally via

checkbox.

The line entries can be selected individually by mouse click. This opens a field with
more detailed information that is clearly structured and understandable. So you don't
spend your valuable time anymore with searching and resolving cryptic entries. If, for
example, a LANCOM employee asks you for essential information in a support case,

this can be transmitted quickly.

The newly designed protocol overviews provide a practical, well-organized and time-

saving way of keeping a constant eye on your network events.
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Properties Users License

B show device log entries

e
Level Created Message By
(@ 23.04202008:23:29 Monitoring initialization started. System
(@  23.04202008:23:29 Monitoring initialization started. System

( 23.04202008:23:11 Management logs have been accessed. atlas-Imctest@cloud Jancom.de

(@  23.04202008:23:10 Putting of configuration to device initiated System
(© 23.04202008:23:09 Configuration-Rollout startad with enabled test mode. System
(@  23.04202008:23:09 Putting of configuration to device initiated System
(D 23.04.202008:23:08 Configuration-Rollout started with enabled test mode. System

() 23.04.202008:23:06 The device Device-9005687031575886 was assigned ta site Aac atlas-imc-test@cloud.lancom.de

()  23.04.202008:23:06 The device Device-9005687031588187 was assigned to site Aache atlas-imc-test@cloud.lancom.de

(D 23.04.202008:22:52 The site Aachen was created. atlas-imctest@cloud lancom.de
Type cloud-service-devices:00012
siteld 7dSegsbf-e806-4513-8a14-25ffaze3f381
siteName Aachen
@  23.04.202008:22:40 ) 2= have been changed. atlas-Imc-test@cloud lancom.de
Type cloud-service-logging:00001
Entity
0ld Value autoFirmwar Successful.enat u
New Value autoFirmwareUpdateSuccessful.er I
autoFirmwareUpdateSuccessful.email={"enabled" false,"recipients™[] "recipientRoles™ {1}
Source 192.168.200.210 - Mozilla/5.0 (Macintosh; Intel Mac OS X 10_15_4) AppleWebKit/537.36 (KHTML, like Gecke) Chrome/81.0.4044.113 Safari/537.36
(@  23.04202008:22:04 Management logs have been accessed. atlas-imctest@cloud lancom.de

- The LMC no longer disables LANconfig’s TFTP-based search on managed

devices.
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LANCOM Management Cloud 1.00.26.0.0.0 / 06.04.2020

Promotion Switch2Cloud - LANCOM switches including free 3-year licen-
se

LANCOM fully managed switches are 100 % cloud-ready and can be managed
automatically via the LANCOM Management Cloud (LMC). Start into the cost- and
time-saving cloud management and receive a free 3-year LMC license (if activated
until September 30, 2020) for every newly purchased LANCOM fully managed
switch until June 30, 2020.

Further improvements

- User-defined columns in the device overview can now be deleted.

Bug fixes
- The location filter in the project dashboard now works reliably for the map
again.
- The VPN connection times in the individual device monitoring are now
displayed correctly.
- The VPN connection throughputs in the individual device monitoring are now

displayed in more easily readable units.
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LANCOM Management Cloud 1.00.25.0.0.0 / 24.03.2020

Further improvements
- The LMC now supports the use of add-ins for one-time, persistent execution
directly in the detailed configuration.
- Support for WPA3 for access points with LCOS LX 5.10

- Further improvements in management and device logs

Bug fixes
- Correction of the output data in the ‘'VPN Connections’ widget in single device

monitoring.
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LANCOM Management Cloud 1.00.24.0.1.0 / 25.02.2020

Rollout Assistant - the quick and easy way to onboard new LANCOM de-
vices in the LANCOM Management Cloud

The initial commissioning and inventory of new LANCOM devices in the LMC is
straightforward with the new Rollout Assistant and takes just a few clicks. The web
app, which was specially designed for mobile use on tablets and smartphones, en-
ables you to perform onboarding to the LMC directly on site after the physical device
installation. The only requirement is that your smartphone or tablet can access the
Internet (LTE, WLAN, etc.). During the inventory using the Rollout Assistant, you can
monitor the current device status live and thus find out during the installation wheth-
er the device has the final status ‘online’ in the LMC.

In the future, a new user role ‘Service Technician’ will be introduced for the LMC. This
role is specifically for users of the Rollout Assistant web app and only gives the

designated persons the authorization to inventory new devices within the LMC.

A, Lancom
Rollou

Q0 Lancom = Q0 Lancom & ‘
Rollout Assistant Rollout Assistant i
"N
i

Rollout Assistant

Selectedproect
My Company

Company

Ty
LTI TH] -

EAN:4 "0441 44875205 4004657332100125

SIN 4004657332100125 ~ tteeee ®

o Site
T T T ———

Add new device 00A0572C0E79

Further improvements
- Improved data access
- History graph for the number of VPN tunnels in the individual device
monitoring
- Table of all VPN tunnels in the individual device monitoring
- Optionally, the management date of the devices can now also be displayed in

the device table (sorting possible).

Bug fixes

- The initial device name did not always contain the LANCOM prefix.
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LANCOM Management Cloud 1.00.23.0.0.0 / 03.02.2020

Further improvements
- It is now possible to access up to one year old log entries.
- The initial name of devices claimed with serial number and PIN has been

shortened for a more compact view in the device table.

Bug fixes

- The button ‘Hide log entries for devices’ does now an accurate filtering.

- Fixed an issue with the display of expired warranties in the Security &
Compliance dashboard

- The link in an invitation e-mail now leads to the account overview.

- The tab ‘Latest activity’ in the user management does no longer show the
status ‘Never’, despite user activity.

- The switch port status for ‘disabled’ and ‘not connected’ is now displayed

accurately again.
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LANCOM Management Cloud 1.00.22.0.0.0 / 13.01.2020

Secure WEBconfig Access

The new highlight feature “Secure WEBconfig Access” allows direct and secure
access to your LANCOM R&S°®Unified Firewall device's WEBconfig — securely
encrypted and above all usable from within the cloud interface. By this direct
remote access to the device’'s WEBconfig the complete Unified Firewall
configuration becomes accessible to a system administrator. A convenient added
value which does not only save time, but particularly unifies the global and indi-

vidual firewall management in the LANCOM Management Cloud.

You can access the LANCOM R&S°®Unified Firewall's WEBconfig in the LMC via the

tab “Detail configuration” in the device’s detail view.

LANCOM LANCOM ~ "
oY, Yrictmac oy i 4

@  Dashboard Devices » Device : UF-406200701005 (LANCOM vFirewall)

Networks Overview Position Detail configuration System information Device log
Locations

The detail configuration of the firewall takes place directly on the device. To authenticate at the firewall you need the device user and the device password.

Devices

= Project specifications

Management

Live Chat

Information area

Guided Tour Project Data protection notice | Terms of use | Imprint
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AW LRNCOM‘ " ﬁ‘ffo‘»ﬂ- 'y Cnnstopn wolgaren s bl

Dashboard Devices > Device : UF-406200701005 (LANCOM vFirewall)

Netwarks Overview Position Detall configuratior System information Device log

Locations R&S Cybersecurity - Login - Mozilla Firefox

& R&S Cybersecurity-Login X [ied
Devices

& c o D lancorr 80% | oo L =

= Project specifications
4 RoHDE&SCHWARZ © Language -

Management

o®  Lvechar

@ information area

© 2014 - 2020 LANCOM Systems GmbH Guided Tour Project Data protection notice | Terms of use | Imprint

One WEBconfig session is supported per device. A previously initiated session is

thereby closed.

Important information for LMC Private installations:
For the subdomain *.devicetunnel under a Private LMC domain (e.g. *.devicetunnel.
customer.tld) the customer needs a wildcard certificate in addition to his LMC

domain certificate.

Further improvements

- Customer-defined columns and views in the device list can be saved per
project.

- The maximum number of devices in the license allocation dialog has been
extended to 100.

- When modifying the cloud connectivity settings for single devices the device
name is now displayed in the subject.

- An initial device name can now be allocated when claiming cloud-ready
devices via API.

- The device services have been extended by TFTP sysinfo and TFTP config.

- While initial access, device configurations can be set to to default values

manually or automatically.

Bug fixes
- The “previous contact” was shown faulty in the “site overview” widget.
- The switch port throughput graph does not change with a new port selection.

- An issue with processing monitoring data under heavy load has been resolved.
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LANCOM Management Cloud 1.00.21.2.0.0 / 03.12.2019

User-defined columns in the devices overview
It is now possible to extend die devices overview page with additional columns.
These columns are freely configurable and can include values which enable the
user to sort and filter the overview by further criteria, for instance to find a certain
device faster.
Examples for user-defined columns:

- Contact person

- Location (e.g. ,Room 4“)

- Customer number (beneficial in large-scale / individual customer installations)

r 1ancom 5 € -
Dashboard Devices =
Networks : S < B -
Locations -

. s = 1P Ada gy tows ¢
Project specifications. AZ0EAG R Ok -
LN-860 oK -
Management 1700 20020002100000¢ 9 ok -
) 900200021001003 2 o -
) 900200021001001 > ok
T 4004202332100249 2 ok -«
N-830ach dual Wieless 4004163818100570 9 ok p—— P
4003933620000045 v oK
405190527709 o
wRouter A025791547894478 o
as23100 4003933820000090 2 o
w700 900200021000001 oK
LN 8300cn dual Wireess 4004163818100114 > ok
17miEs 4004202332100250 v 2 ok
s 9002002100105 ok
w700 900200021000005 oK
1781VA (ver ISON) 4002759618100145 > o
17siese 4004202332100108 > o
) 900200021001000 2 ok

00126 selected

[207page ~

@ information area
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User-defined columns in the locations overview
In the locations overview, as well, user-defined columns can now be added.
Just like in the devices overview, you have the option to sort the overview by all

columns.

Ay LaNCOM & My Company~ @

Location : Barcelona

Neworks  Internet Secury WA Hoispot  Devies  Floorplan

Address

Steet /

SDN v+

EL BORN
uuuuu ,
o LA RIBERA

o CIUTAT VELLA

Description

Custom fields +

Further improvements
- The LMC now supports the option to choose whether the layer-7 application
detection is applied to access points or gateways.
- Support of LCOS 10.40
- As from LCOS 10.40 LMC-managed devices can be found via the LANconfig
search tool.
- LLDP can now be configured individually on a device level.

Bug fixes
- If an access point is offline, Wi-Fi channels can be configured via the

floorplans nonetheless.

LANCOM

SYSTEMS




128 Release Notes - LMC Software Release up to 1.00.180.0

LANCOM Management Cloud 1.00.20.0.0.0 / 12.11.2019

CLOUD-MANA
FIREWALL

Cloud-managed firewall

The LANCOM R&S°Unified Firewalls are now cloud-ready! Devices are connected
to the LANCOM Management Cloud (LMC) by a simple yet secure PIN- or activation
code-based pairing procedure. They then appear in the device overview, which
offers clearly structured monitoring of the device status and also features an
alerting function. On top of that, having a firewall in your network all applications
tagged with ,LCOS FX" within the feature ,Application Management” can be
provided with rules.

Note: The support for the web-based configuration interface of the LANCOM
R&S°Unified Firewalls, as well as the support for the LANCOM R&S®Unified Firewall

UF-50 follows in one of the next LMC releases.

Further improvements
- It is now possible to hide / unhide columns in the device- and location

overview.

Bug fixes

- An issue has been fixed for the device list and location overview in the
location filter of the LAN-/Wi-Fi dashboard.

- The “Further VPN connections” display has been corrected in the WAN-/VPN
dashboard.

- Cancelling a page change in the project presets does no longer result in a loss
of all previously changed settings.

- The speed limitation for an SSID is now set on a LANCOM LW-500, too.

- Wi-Fi channel allocation now works on the LANCOM LW-500, too.
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LANCOM Management Cloud 1.00.19.0.0.0 / 21.10.2019

Application Management — Convenient control over all applications in
your hetwork

Now you can control even more conveniently which applications you allow or block
in your networks in the LANCOM Management Cloud.

As the successor to the previous Application Routing, the new Application
Management allows you to group several applications into one rule. The respective
rule is assigned an action. In addition to routing applications, as it has already
been possible in the Application Routing, the “Block Applications” function is now

available.

These rules are created with just a few clicks. The corresponding input field allows
you to find known applications quickly by name, and also a convenient selection

of predefined application categories such as gaming, streaming, business or
messaging, in which several similar applications are grouped.

This feature significantly increases the security of your network by allowing you

to block the use of particular services within your network. You can also increase
performance because you can allow a local breakout for secure applications so that
their Internet traffic no longer has to be routed over your central site.

Note: The shown support for LCOS FX in the screenshot is available from version

Overview Wi-Fi Switches Application Management
Please select an application to create a rule: m
Search for applications v -
[ Applications Action Camment
FasTalL il Ghix i icLou-tiaiL i maicHive J§f wEB DE | Steer ¥ Mail - Local Breakout
Routing target
Lacal internet gateway v
[ Categories Action Comment
Block ~ Elock File Sharing #

Further improvements
- Passwords for LANCOM R&S°®Unified Firewalls can now be set from within the
LMC.

Bug fixes
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- Executed addIns are now listed in the log by order of execution.

- Correction when trying to type a device name containing blank characters
- Corrected site filter in the Wi-Fi dashboard for site- and device overview
- Corrected DNS display for Wi-Fi connections

- Corrected security rating for device services

- Corrected dashboard display for devices with safety-critical services

- The checkbox for disabling emailing if notifications have been closed

automatically has been removed.

Miscellaneous

- The number of variables has been reduced to 250 per project.
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LANCOM Management Cloud 1.00.17.2.0.0 (1.20.0) / 10.09.2019

SD-WAN performance at a glance

The LANCOM Management Cloud provides a simple overview of your SD-WAN
setup and thus of all VPN connections in a network.

For even more control of your SD-WAN, it is now possible to display performance
values for a selected VPN connection on the map in addition to a tabular view. This
enables end-to-end quality monitoring, e.g. up to VolP- or application servers in the
SD-WAN.

The widget ‘Site Interconnection Overview’ in the WAN / VPN dashboard shows
current performance values such as throughput, packet loss, delay, and jitter for all
VPN connections.

Performance monitoring can be activated in the configuration dialog for each
network. The monitoring target for the measurement is also defined there, allowing
individual and flexible quality monitoring.

Note: Performance monitoring is supported by all LANCOM VPN Gateways as of
LCOS 10.30.

Dashboard: WAN / VPN ~ Location: All ~ / custo
Site Interconnection A ]
L5 Dortmund
status Branch Branchlocation  Newwork  Centralste  Location  Connection time t Map Satelte || Legend o fa gy Endioven |\ s 8]
Canterbury ) F . - e
London-VPN London | Wirselen  6Days, 18:51:58h Ch Brlgge r~, _Antwerpen ~N /- Disseldorf
= 5 + %
fer Wien Wiksclen  &Daysld5208h Calais 9Dl Network Connection = Kgln
= o
Hamburg PN Worselen 6 Days, 18:51:02 h Bonn
hen on
Madrid PN Warselen 6 Days, 1851:43 h
Kiel-VP Kiel Wirselen 6 Days, 18:5208 h Koblenz
Athen | Wirselen  6Days, 18:5139h
Schweiz V. Worselen 6 Days, 18:51:16 h B bade
Amiens o N 7 N\ .
Karlsruhe PN Worselen 6 Days, 1851:30 h { it
mburg
Paris PN Wirselen 6 Days, 185211 h S
Rogen O~
Munchen Wirselen 6 Days, 18:51:59 h Rems ——
Ror N Warselen  6Days, 18:51:56 h Metz = - !
Dublin PN Warselen 6 Days, 18:5205 h I
Berin Warselen 6 Days, 18:50.24 h

Show map

Edit network 'SD-WAN'

General Internet DHCP DNS Routing

3 Performance Monitoring

192.168.37.244

Performance Monitoring actively checks the quality of the VRN
connection from the branch device to the specified monitoring target.
For each connection, the values Round Trip Time, Packet Loss and Jitter
are monitored. Determining the Jitter value requires the LCOS version
10.30.on branch devices.

The collected values are displayed in the VPN dashboard in the Site
Interconnection widget for each connection

[ Tag network data (vLAN)

Layer-7 detection Apps including user tracking §
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Further improvements

- The device table can be filtered and sorted by configuration status.

Bug fixes

- A faulty default value for miscellaneous Wi-Fi router types running LCOS 10.30
has been fixed. The configuration roll out for these devices is possible again
without manual editing.

- In the detail configuration dynamic tables with more than 100 entries are
spread across multiple pages, so tables with more than 999 entries can now
be displayed correctly.

- Application Steering creates firewall objects only as individual entries if these
were not part of the configuration before. This behaviour prevents duplicate

entries when editing firewall rules with LANconfig.
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LANCOM Management Cloud 1.00.17.0.2.0 (1.19.1) / 20.08.2019

Secure Terminal Access - Device access directly from the cloud

The new highlight feature Secure Terminal Access allows you direct access to the
command line of your LANCOM device (“CLI tunneling”) - securely encrypted and
above all without leaving the cloud interface.

Whether “Trace” and “Ping”“ commands for fast troubleshooting, access to low-level
configuration parameters and detailed statistics of the LCOS operating system or
secure remote access to external devices in the local network via the integrated
SSH client - Secure Terminal Access provides you with expert functions as well as
extensive diagnostic and troubleshooting commands for LCOS-based devices.

A practical added value for all system administrators that not only saves time,

but above all combines global and individual device management in the LANCOM

Management Cloud.

Note: To use Secure Terminal Access, the devices to be configured currently require
the LCOS firmware 10.30 RU1 or higher. Administrator rights are required for use in
the LMC. Support of the Secure Terminal Access function for the operating systems
LCOS LX and LCOS SX is already in preparation.

T o o
ot

Secure Terminal Access LANCOM-ANIT02
(& Configuration roll out
Firmware update
Open secure terminal
Firmware Reboot device
Transfer device

Remove device

Assignlicense

Detach license
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VPN Performance Monitoring

The LANCOM Management Cloud allows for a simple overview of all VPN
connections within your network.

Now it is possible to monitor the performance values for throughput, MTU, packet

loss, roundtrip time, and jitter in the detail view on the map, too.

LANCOM >l SDN-DEMO (LANCOM Visitor)~
ol Frintnn PR '

= Project

Dashboard Dashboard: WAN / VPN ~ Location: Wiirselen -

Networks
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‘ Network Connectio
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- e & Litauen
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- Isle of Man Packet loss: 0% Mimck

Project specifications ol Manchester °

U !

iHand Liverpool d Polen Welbrussland
[VELE T AITISE T r g
©
L@’" Niederlande, Warihau
Brllsgel CHOI0
p 0> Deutschland : Kiew
Belgier Prag *
& % ®
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b Ukr:

~ ) Ba. sl
Kartendaten & 2010 GeoBasis-DE/EKS (£2009), Gaogle Inst. Geas
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For this, VPN Performance Monitoring can be enabled per network in the network
configuration, and the endpoint for the measurement can be specified. A firmware

version LCOS 10.30 or newer is required.

Edit network 'VoIP"

General Internet DHCP DNS Routing

[ U= same subnet o e [ocaton ’

VPN Performance Monitoring actively checks the quality of the VPN connection from the branch device to the
specified monitoring target. For each connection, the values Round Trip Time, Packet Loss and Jitter are monitored.
Determining the itter value requires the LCOS version 10.30 on branch devices.

Tag newwork data (VLAN)

[ Layer-7 detection Apps including user tracking ¥

Cancel Save

Further improvements
- The loading time for project dashboards with many sites and devices has been

optimized.
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LANCOM Management Cloud 1.00.16.2.0.0 / 01.08.2019

Two-factor authentication — Double the security now also for individual
projects!

With the extension of the two-factor authentication feature, you now not only
safeguard your cloud access, but also individual projects against unauthorized
access. Thus, project administrators can specify that users can only access or
work with this project if they use two-factor authentication when logging in.

For this purpose, the self-chosen access password is supplemented by a time-
based one-time password which can be generated on the mobile phone using an
authentication app (e.g. Google Authenticator). The ideal solution if the project

customer has to meet certain compliance and security requirements regarding data

security or if the main administration wishes to enforce a higher security level.

Two-factor authentication required

In order to access this project, you have to log in using two-factor authentication. You can activate this in your user

prof

Further improvements
- New filter option in the device list for devices in pre-claimed status
- New filter option in the device list for device firmware

- Performance improvements in the device list, especially when switching tables

Bug fixes
- Corrected throughput graphs for switches
- Improved error messages for two-factor authentication
- Fix for an issue which erroneously caused an error message while registering
a new user

- Corrected a display error on the VPN tab in Microsoft Edge

& LANCOM

SYSTEMS




136 Release Notes - LMC Software Release up to 1.00.180.0

- Corrected projects device count on the organization dashboard
- Miscellaneous bug fixes in the device list
- Runtime limitation for API-generated pairing tokens to a maximum of one year

- Corrected API for request of device data and -statistics
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LANCOM Management Cloud 1.00.16.1.0.0 / 18.07.2019

SD-WAN Application Routing — The shortcut to more efficiency!

Benefit from significant performance gains when you operate modern cloud

applications (e.g. Office 365, SalesForce, etc.). SD-WAN Application Routing

detects cloud-based applications and routes them directly to the Internet (local

break-out). This boosts your cloud applications and relives the VPN path to the

headquarters as well as the headquarter's Internet line.

o % frieiasd
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LANCOM Management Cloud 1.00.16.0.0.0 / 09.07.2019

Announcement
In the next sprints, the APIs for authentication will change to be fully RFC-7617 com-

pliant. This may affect users which are directly interacting with the APIs.

Two-factor authentication

Activate two-factor authentication

Use Google Authenticator (or any other authenticator supporting TOTP) on your smartphone to generate a time-based one-
time password to authenticate with the LMC. This service does not require any network connection.

In order to activate two-factor authentication, please install the authenticator on your smartphone and scan the QR code
below with the app.

Alternatively, you can enter the secret manually.

SRQEXGIVJEV7GB5BFOXZZRMT6XZTD3NX

Verify your password

Verify the code for this secret

Cancel Activate

Two-factor authentication secures your LMC access. Besides your password, you
will be asked for an additional factor. This factor is a time-based one-time password
based on RFC-6238, using a 160-bit key.

This process can be activated individually for each user. Scan the QR code with
an authenticator (e.g. Google Authenticator) or enter the key manually. At the next
login, enter your username and password as usual. Subsequently, you will be asked

to additionally enter the currently valid one-time password.

You can disable this process at any time by entering your password and current
code. Should you have lost your device, you can reset your password as usual - as a

consequence, the two-factor authentication will be disabled, too.

In one of the further releases, this functionality will be extended: You can then
specify that your projects require a two-factor authentication: Each user who wants

to enter the project has then to be authenticated with two-factor authentication.

& LANCOM

SYSTEMS




139 Release Notes - LMC Software Release up to 1.00.180.0

Improvements
- Write access is now disabled by default on switches which are managed by
the LMC.

Bugfixes
- Several issues fixed with the CSV export of monitoring data

- Optimizations when adding and deleting multiple networks at a site
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LANCOM Management Cloud 1.00.14.0.3.0 / 06.05.2019

What's new dialog
Innovations in the LANCOM Management Cloud are now displayed via a What's new
dialog. It will be displayed once for each new version and inform you about the most

important news. Of course, you can always deactivate or reactivate this dialog.

Improvements
- Support for the LANCOM LW-500
- The organization dashboard has been optimized for large-scale projects.
- Locations now have an address and a comment function.

- Wi-Fi inter station traffic is now switchable in the SD-WLAN configuration.

Bugfixes

- When new filters have been applied to the device list, the previous selection
remained active for the user.

- The operation “Select all” did not select all devices from the device list.

-> Issues occured when displaying the organization overview under Google
Chrome.

- Miscellaneous issues solved related to the determination of the heartbeat
condition of devices

- An “HTTP 404 - Resource not found” error could occur in the device list in
some cases.

- Prevention of a DNS forwarding misconfiguration when using multiple central-
site VPN gateways

- Wi-Fi country settings are no longer set to Europe by default.
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LANCOM Management Cloud 1.00.13.0.1.0 / 15.04.2019

Online / offline status for devices in the location overview
The map in the location overview now shows the proportional online and offline
status of all devices in all locations. Previously, the whole location was tagged as

offline when at least one device was offline.

Locations Overview
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Bugfixes

- Fixed an issue which caused the non-appearance of log messages, e-mails
etc.

- The switch port speed settings, particularly for the SFP/SFP+ ports, are no
longer set fixed to “auto”, but are now applied from the detail configuration.

- The download of QR codes for the Wi-Fi SSID is working again.

- Devices can be removed from locations again when using the Firefox browser.

- Display issues have been fixed which caused a missing “save” button in
particular situations in the detail configuration and the switch overview.

- Update procedures of full configurations are now displayed on the device

information overview page.

Miscellaneous

- The dialogue for adding devices to locations has been optimized.
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LANCOM Management Cloud 1.00.13.0.0.0 / 25.03.2019

Notifications
The notification feature is leaving beta. Along with that, the following changes have
been implemented:

- For many event types only one notification is open at a time. A new notification
is created only if the previous issue has been solved, or has been closed by
the administrator.

- You receive a message for an open notification if the system status
subsequently gets worse: if only one device is affected initially, but more
devices become affected later, you will be notified.

- As before, some notifications are grouped: if multiple devices fail at the same
time, only one notification is generated and you will get only one e-mail

Handling and visualization have not changed.

Improvements
- The sorting of columns in the device table is now saved.
- The claiming process for adding new devices to the LMC has been stabilized.
- Itis now possible to re-enter the location- and device overviews from the CSV
import dialog box.
- The LANCOM IAP-4G+ is now supported by the LMC.

Bugfixes
- Issues when centering map sections of projects and locations have been
solved.
- It is possible again to navigate to the menu items of the LMC after opening an

invitation link.

Miscellaneous

- Changes to the license service API
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LANCOM Management Cloud 1.00.12.2.0.0 / 04.03.2019

Announcement
The notification feature will soon be ready for leaving beta status. Along with that,

all open and already closed notifications will be deleted at this particular time.

Improvements
- Updated license notes for CLA licenses
- The device table now supports filtering by device status.
- The location device table now supports sorting and filtering by various

columns.

Bugfixes

- A behavior which prevented log messages for status changes has been
corrected.

- An issue which prevented the display of Wi-Fi clients on a floorplan has been
fixed.

- The throughput indicator for VPN site connections on the dashboard has been
fixed.

- An issue regarding the reuse of device connections to the LMC in private
cloud installations has been fixed.

- Mails about expiring licenses are now sent to all project administrators.
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LANCOM Management Cloud 1.00.12.0.0.0 / 11.02.2019

Announcement
The notification feature will soon be ready for leaving beta status. Along with that,

all open and already closed notifications will be deleted at this particular time.

Improvements
- Improvements in account selection and account overview. Now the five
previously opened projects are displayed.
- Improved LMC loading times
- Performance improvements in various dashboard widgets
- Improved navigation in the VPN connection table
- Improved device log display for mobile Internet connections
- Improved alert display for mobile Internet connections

- The sorting of the device table has now effect on the complete database.

Bugfixes

- Correct DNS forwarding rules when Internet access is provided via the VPN
central site.

- Access points and switches can be assigned even if a subnet on that location
has no IP addresses available.

- Fixed sorting of the voice call routing table in the detail configuration

- If the password policy “randomly individual”“ is selected when creating a new
project, this setting is applied accurately.

- Fixed display for the LANCOM 1906VA-4G (over POTS)

- Improvements and bugfixes for logging and firmware status display in
conjunction with the auto updater

- The live chat is working completely again.

- Fixed some issues regarding temporary connection loss of LCOS devices,
resulting in false online/offline alerts. An update to LCOS 10.20 RU3 is

mandatory for this.
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LANCOM Management Cloud 1.00.10.3.0.0 / 13.12.2018

Complete Auto Updater Support

For LCOS devices with activated Auto Updater an Auto Updater icon is now
displayed in the firmware column of the device table. If there are updates available
for one or more devices based on their Auto Updater settings, the user receives a
summarizing notification and an optional e-mail about this event. As is usual, the
user is made aware of available firmware updates for devices without activated
Auto Updater visually in the device table, too. These firmware updates can then be

installed manually.

(& Refresh
CONFIGURATION LICEMSE FIRMWARE

OK (18.08.2021) 0.20.033¢ O

OK (17.08.2020) 0.20.0331 ]

OK (11.08.2020) il

OK (17.08.2020) : 5|

9 Nolicense m|

0 of & selected
A John Smith -

Motifications

Automatic firmware update successful

Automatic firmware update on 4 devices., 2 days ago
Automatic firmware update failed
Failed to automatically update firmware on device: Device 2 days ago

Automatic firmware update successful
Automatic firmware update on 3 devices: Device-006

All notifications

2 days ago
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Further improvements
- Offline notifications for individual devices do now include the device name in
the e-mail subject.

- The location’s network overview offers a survey of the allocated IP ranges.

Bugfixes
- The selection “device-specific settings” works again in the project defaults.
- On managed gateways the correct sender interface for the LCOS Auto
Updater is now set if the LCOS Auto Updater has been activated via project
defaults.

- Changing the device name on the device overview page works again.
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LANCOM Management Cloud 1.00.10.0.0.0 / 21.11.2018

Alerts that reassure

The LANCOM Management Cloud automatically informs you when your system

is malfunctioning. The practical notification center in the LANCOM Management

Cloud helps you keep track of important network events at all times: Be informed

on device- and other failures and notice once a problem has been solved. You can

individually configure which events are notified to whom at what time. Furthermore,

related events are consolidatedly displayed — without the risk of spam.

This feature is currently in beta status. More functionality is yet to come.

Musterfirma GmbH ~ £ €% Max Mustermann ~
Project N ¥ Project Administrator
Dashboard: Wi-Fi / LAN ~ Location: - Notifications
Device offline
Device Count Wi-Fi Users Device AP-Erdgeschoss is offline. 7 days ago
Online Offline Count  Mbps | 24GHz 5GHz
3 75% 1 0.18 0 6 Device offline
Device AP-Oberges 7 days ago
; : Device offline
Locations Overview Top Users|  p..ice ap-obergeschoss s offline. 7 days ago
[rmeroen N
ame
Map  Satellite @
Kk M " Device offline .
3 DirkBoliPh(  The following devices are offline: AP-Obergeschoss, Sw 8 days ago
ich r Hamburg ]
+ gheste o La Sandras-iP
1 — ol Device offline .
- Amsterdam Beg'" dbolte-nb | 4 devices are offline. 9 days ago
)
London Netherlands Sercomm All notifications
® 5
Brussels Cologne  Germany Apple TV S
ol
Beighm Frankfurt Prague DirkBoltesiPad | dcadcadc:23:6¢c | 253 MByte | 1005.00 kByte | 1.55 MByte
Luxembour
S Y Czechia
:
e 2 ) 2 1-60f8
Munich Vien
t ®

Further improvements

- In the switch device overview settings for a selected port can simply be
copied to other ports. Using this function, the similar configuration of many
ports gets much easier and faster.

- In the switch port masks of the network definition all ports can now be
selected or deselected in common.

- The CSV location import allows reading of Zscaler authentication data.

- Tables with explicit sequence, e.g. the action table, now can be sorted within
the detail configuration.

- In the Security & Compliance Dashboard login names of admin logins are now
shown under details.

- In the device inforrmation of the device overview the prorated uptime for a

device in the is shown for the last 7 days.

Bugfixes
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accurately again
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LANCOM Management Cloud 1.00.9.5.0.0 / 29.10.2018

Security & Compliance Dashboard

The new Security & Compliance Dashboard shows at a glance whether the devices
in the network are configured according to corporate security policies.

Furthermore, the dashboard keeps you up to date regarding the remaining device
warranty and license terms. Intuitive, color-coded status information makes it easier
than ever to meet security and compliance requirements in cloud-managed

infrastructures.

Dashboard Dashboard: Security / Compliance = Location: All ~

Networks

Locations Main Device Passwords Devices Licenses 0 0 Devices Configuration 7
Modify > Devices overview > St 2 X Devices overview > L

Devices

Addins Gateway Connections (last 10 minutes)

3 Project spedifications

Management +

Further improvements
- Added a link to the device list for direct location access
- Added a link for direct access to the individual device overview in a location’s

device allocation

Bugfixes
- If SD-WAN is disabled in the LMC, lately created networks can be allocated to
locations accurately again.
- The conversion of VolIP configurations for analog users has been corrected
when switching over to LCOS version 10.20.
- The device name of managed switches is now set accurately.

- Miscellaneous display bugfixes
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LANCOM Management Cloud 1.00.9.4.1.0 / 15.10.2018

Bulk import: Time savings on a large scale

In large-scale scenarios, the creation of sites, the allocation of networks or the
addition of new devices can be laborious. Instead, prepare your large scenario with
a spreadsheet program and import the information via CSV into the LANCOM

Management Cloud.

Upload

New features

- The SD-WLAN function of the LMC now supports WPA3-secured wireless
networks.

- The LMC can specify for each project how the LCOS Auto Updater is to be
operated so that the devices are automatically kept up to date with the latest
LCOsS.

- The SD-WAN function of the LMC supports the decoupling of individual

networks via the secure Internet access products of Zscaler.

Improvements
- The unencrypted management protocols (SNMP1/2, Telnet, HTTP, and TFTP)

are automatically disabled on devices managed by the LMC.

Bug fixes
- When networks are created while SD-WAN is deactivated, they can be
correctly assigned to a location again. Networks that were created incorrectly
can be corrected by saving the network settings again.
- When a VPN network is removed, the corresponding devices are set to
“Outdated”.
- The display of the checkbox selection in the detailed configuration has been

corrected.
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LANCOM Management Cloud 1.00.9.0.2.0 / 17.09.2018

Searching, sorting, and filtering in lists

You are managing multi-site projects? As a Managed Services Provider, you are
managing a big amount of projects? The new functions for page-spanning sorting
and filtering in lists make it easier and much more comfortable to find the desired
entry.

This convenient function is available for site-, user-, and project lists.

Client IP Client MAC AP name T
| || [30: |
192.168.2.242 30:07:4d:f1.69;24

G2.168.2.19 f8:77.b8:50:30:48

Mobile quality indicator
As known from mobile radio devices, the WAN connection table in the individual
device monitoring offers now a quality indicator for mobile WAN connections. See

and evaluate at a glance every important detail of any mobile connection.

WAN Connections X
Status ~ Remote name Connection time Details Channel DN server Provider gateway

INTERNET 9Days, 23:2408h VM 1GBitls DSL-CH-1 17216.2.253 172.16.2.253

EPLUS 01:04:48 h LTE (4G) EXT DHCR AU Sa109 12017 1077
Home netwark (MEDIONmabile) 62.109.121.18
Band B20 800 MHz
il Signal-63 dBm

1-20f2Items

Further new features
- With activated add-ins: One script part can be executed per branch office on

Central Site devices.

Improvements

- In the service table you can now categorize the available device services by
criticality.

- The global time range selection in the individual device monitoring is now
always visible.

- Useful user feedback for the brute force protection for claiming

- When specifying the location ID for rollout the underscores at the end of the
ID can be dropped.

- Miscellaneous internal improvements
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- Additional interface bindings can be allocated to the untagged network
(default VLAN) via detail configuration.

- Miscellaneous bugfixes for the Ul
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LANCOM Management Cloud 1.00.6.1.1.0 / 08.08.2018

New features

- The password management of the LMC can optionally allocate individual
passwords to the managed devices automatically.

- Variables with a pre-defined selection can be created for usage associated
with add-ins.

- Mouse zoom function for history graphs on the individual device monitoring
page.

- Itis now possible to sort for e-mail addresses in the user table.

Improvements

- For WLAN SSIDs the roaming optimization 802.11r can be activated in a
compatibility mode, which allows the operation of not 802.11r capable Wi-Fi
clients, too.

- The LMC can set an explicitly configured sender network for communication
with the RADIUS server with WPA Enterprise (802.x) on Wi-Fi routers.

- The LMC location ID is applied to the DHCP server for automatic location
determination for appropriately configured networks.

- Automatic defaults when selecting a date for the history graphs in the

individual device monitoring.

Bug fixes

- Issues in the VPN dashboard with deactivated SD-WAN have been fixed.

- An issue in the location overview of the VPN dashboard for locations without
position has been fixed.

- The missing display of the WAN throughput for LANCOM 7100 and 9100 series
devices has been fixed.

- A faulty display in the graph tooltip with missing data has been fixed.

- The editing of DHCP forwarding settings in the network properties has been
corrected.

- The display of the page for editing ground plans has been corrected.

- If creating an allocated add-in for a device aborts with activated add-ins

functionality, the entire configuration will not be uploaded.
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LANCOM Management Cloud 1.00.5.2.0.0 / 19.07.2018

New features

- Detail information is shown in the history graphs when clicking and hovering
with the mouse.

- User-defined time range selection for history graphs in the individual device
monitoring

- The rollout can now be performed based on the location information the
managed device passes to the LMC (allocation possible via DHCP option and
rollout wizard as from LCOS 10.20).

- Support for WLAN client management (preliminary for LCOS 10.20)

- Support for new device types

Improvements

- The device name can now be edited on the device overview page.

- Optimization of requests in the location table with performance optimization in
scenarios with many locations

- The clustering of neighbored devices in the location overview map has been
optimized for bigger projects.

- If interfaces are already allocated to a VLAN which is managed by the
software-defined function, these are added from the detail configuration to

the resulting interface allocation.

Bug fixes

- The allocation of location groups in the monitoring with direct device
allocation was corrected.

- The display of the number of Wi-Fi clients in the 5 GHz band has been
corrected in the floor plans.

- The content of the top user table in the Wi-Fi dashboard has been corrected
after a location change.

- The configuration for 28-port switches has been corrected.

- If cloud-ready devices are allocated to a project and location using their serial
number and PIN, the correct function is now assigned.

- The function of the checkbox in the function assignment for devices at a
location has been corrected.

- The target for forwarded DNS suffixes at the branch site is now set to the
corresponding IP address of the central site device.

- VPN tunnels are displayed accurately at the branch site, even if the defined
IP address range of the related network is completely covered by a manually

created, additional route.
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- Automatically generated configuration parameters (by the software-defined
function) can be displayed by a project viewer again.
- With activated add-In functionality
« the dedicated add-in variables are now sortable on network- and device
level
« the script editor is again available write-protected for project members

- Miscellaneous internal bug fixes and improvements
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LANCOM Management Cloud 1.00.4.4.2.0 / 08.06.2018

New features
- The project view can be focused on the desired intended use SD-WAN,
SD-LAN or SD-WLAN. For this, all not needed elements are disabled.

Improvements
- The device status of the gateway can be easily viewed by selecting a location
on the VPN dashboard map.
- A combined status from registration and line status is displayed in the
telephony service table.

win

- Functions with contextual help texts are now marked by a blue “i”. The help
text is displayed by clicking the blue “i".

- Support for the LANCOM 1640E

- In the dialogue for the network settings management the tab can be changed
even if not all necessary settings have been made.

-> Reworked license pool and -key view

- Networks (VLANSs) without SSIDs are allocated exclusively to LAN interfaces
on access points.

- The default project location contains the default network, too.

- When adding a device, a location can be optionally selected.

Bug fixes

- Under certain circumstances connections in the WAN connection table were
displayed twice and with different status.

- The linking of IPv6 addresses in the WAN connection table has been fixed.

- Successively modifying and saving within the detail configuration could lead
to errors when saving the entire configuration.

- An issue has been fixed which could cause Wi-Fi clients learning the VLAN 1
IPv6 prefix (even if they should not be part of this VLAN).

- If the only one configured VDSL connection of a router is broken, the WAN
connection table is still displayed in the individual device monitoring.

- An issue has been fixed which could cause the status of the VPN connections
in the VPN dashboard switching between green and orange infrequently.

- The display speed of the project- and device logs has been improved

dramatically.
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LANCOM Management Cloud 1.00.4.1.1.0 / 15.05.2018

Improvements
- Follow-up licenses can now be allocated to devices. These licenses are used
automatically after the current licenses have expired.
- Opting-in to the LMC Newsflash can now be done from within the user profile.
- The time range selection (hour / day / week) in the individual device
monitoring applies now to all widgets on this page.
-> For map zooming you now have to additionally press the CTRL key to prevent

zooming when scrolling through the page.

Bug fixes
- The displayed number of devices of a location has been corrected.
- If no SSID was allocated to the network with the default VLAN 1, a faulty VLAN
configuration could lead to IPv6 connection issues.
- A blocked route generated needless routing entries at the branch offices.

- Miscellaneous internal bug fixes and improvements
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LANCOM Management Cloud 1.00.3.28.2.0/12.03.2018

New features

- Setup of redundant central site VPN gateways

Further improvements

- The device list of a location now shows the function of every device, e.g.
“Gateway”, “AP” or “Switch”.

- Added an option to the location’s device list to define which networks of the
current location should be applied to each device’s configuration.

- On the overview page of a device the “WAN connections” table shows the
negotiated speed of the respective connection.

- Information about cellular connections is available on the overview page of a
device.

- On the overview page of a device the table “Phone services” shows a detailed
line status.

- Selecting a single line in the graphs for single devices is possible directly via
the legend.

- In the detail configuration of a device existing lines of dynamic tables can be

copied as template for new entries.

Bug fixes

- Particular street types were not displayed in map view.

- The map position was not saved accurately in map view.

- Firmware updates can only be triggered when the previous firmware update

has been finished.

- Incorrect links to the Guided Tour videos have been fixed.

- When setting or unsetting the mark for “Set main device passwords globally”
the configuration status of the devices is set to “outdated”, because these
changes are applied only after writing the configuration back again.

- The device icons on the floor plan are the same size now.
- Device logs can now be viewed by project administrators and project
members. Project logs can still be viewed only by project administrators.

- The device filter in the device list works correctly again when using Firefox.
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LANCOM Management Cloud 1.00.3.23.1.0 / 12.03.2018

New features
- All WAN connections at a glance: A new table gives you a clear comprehension
of the working status of configured WAN connections. This information is

available under “Project > Devices > Individual device > Overview”.

Further improvements
- A user gets an additional warning now when trying to change a network’s
central site, because massive VPN configuration changes will occur by this.
- For deleting a project, a password has to be specified now. Furthermore, a
message pops up, if devices and / or licenses are still allocated to the project.
- Throughput for multiple WAN connections of the same type is separately
displayed within graphs.

-> Essential internal improvements on processing monitoring data

Bug fixes

- After adding license keys, the dialogue closes now and the user gets a
notification that the action was successful.

- In the DHCP table you can now filter by type.

- The DHCP table contains a link to the network with the appropriate client.

- The call routing table is displayed accurately again. In certain scenarios an
empty table was mistakenly displayed in the individual device configuration.
However, configuration data was not affected by this.

- Devices on the map dashboard were not always displayed at the correct
position.

- The calculation of the Wi-Fi users within projects has been improved.

LANCOM

SYSTEMS




161 Release Notes - LMC Software Release up to 1.00.180.0

LANCOM Management Cloud 1.00.3.19.3.0 / 20.02.2018

New features

- The active and inactive services (e.g. SSH, HTTP, SNMPv2) of a device are
now shown in the individual device monitoring, including additional information
about the ports and interfaces on which the services are accessible. It is
possible to filter and sort for all properties.

- The DHCP clients table is now shown for devices with enabled DHCP server
in the individual device monitoring. It is possible to filter and sort for all
properties.

- Devices which are added to a project can now be allocated to a site,
depending on their internal IP address. Provided that a unique IP subnet
has been allocated to each site, the device’s site can be determined by its

allocated IP address.

Further improvements

- On the site selection dashboard it is now possible to search for a particular
site.

- The selected site on the dashboard is now saved when leaving the dashboard.

- The selected map view (street / satellite) is now saved when leaving the
dashboard.

- The name of a network can now be changed.

- The name of a site can now be changed.

- Miscellaneous detail improvements for the user interface

Bug fixes

- Miscellaneous internal performance- and stability improvements in the
monitoring section

- Inconsistencies between the dashboard widgets for Wi-Fi users and Wi-Fi
throughput have been fixed.

- The VPN dashboard displayed an inaccurate number of VPN connections in
particular cases.

- The selected amount of devices which have to be shown in the device list is
now stored properly.

- After having successfully added a license key to the license pool, the
corresponding dialogoue closes without problems.

- An issue with the display of the automatic port labeling in the individual device

monitoring for switches has been fixed.
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LANCOM Management Cloud 1.00.3.15.5.0 / 30.01.2018

New features
- Local configuration changes on the devices are now reported to the LMC (as
from LCOS v10.12 RU4). From within the LMC there are options to apply these
changes to the configuration, to inform about the changes, or to actively reset
the changes on the device.
- The management of subnetworks at each location now allows the manual
specification of networks of your choosing in addition to the subnets that are

assigned from the central pool.

Further improvements

- Devices can now be restarted from the LMC.

- Installing a new firmware version no longer leads to an automatic rollout of the
configuration.

- The display of the previous week’s monitoring data on the dashboard has
been modified.

- Responsive design and optimizations for the detailed configuration of devices

- Members and viewers can now see whether devices in the device list are
operating the current firmware.

- Improved user feedback when too many attempts were made to add a device
with the wrong PIN.

- Users can now remove themselves from an organization/project, unless they
are the last-remaining administrator.

- If an individual device configuration has been set with a sender interface for
communications with the LMC, this is no longer overwritten by the Smart
Config.

Bug fixes
- Modified site locations are stored accurately again.
- An issue was solved which caused the device configuration status in the
device list to remain on “updating”.

- Miscellaneous bugfixes for dashboard and device monitoring
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LANCOM Management Cloud 1.00.3.11.0.0 / 14.12.2017

New features
- Comfortable configuration of a simple hotspot via the LMC
- In the new area “Project specifications” general settings can be configured
project-wide (e.g. main device password, band steering, hotspot, ...).
- A new color marker in the device list shows if the device is running the current
firmware, or if a new firmware is available.

- Alink to the LANCOM knowledgebase was placed In the info area.

Further improvements
- The “add device” dialogue has been reworked and shows now where to find
the needed information (S/N+PIN).
- A message is now saved to the device log, if a device could not retrieve a new
firmware from the LMC successfully.
- VPN dashboard: VPN connection lines are now selectable and show the
connection status and containing networks.

- VPN dashboard: Reworked information overview when selecting a location.

Bug fixes

- The device detail view on the floor plans shows the picture of the device in
correct size again.

- In some cases device remained on the floor plan after deleting them from the
location.

- The 5-GHz Wi-Fi coverage is only shown on the floor plan for devices which
do actually broadcast a

- 5-GHz network.

- Anissue when configuring dual radio 11ac access points has been fixed.

- Issues when configuring LANCOM 883 and LANCOM 884 devices have been
fixed.

- Several internal bug fixes and performance improvements
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LANCOM Management Cloud 1.00.3.8.0.0 / 29.11.2017

New features

- Direct graphical network assignment on switch ports in the switch overview

Further improvements
- Upload of up to 15 floor plans per location (previously 5)

- The login process has been speeded up.

Bug fixes
- A problem with the PoE configuration of the GS-2352P has been fixed.

- Miscellaneous internal bug fixes and stability improvements
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LANCOM Management Cloud 1.00.3.6.3.0 / 12.10.2017

New features
- Custom Fields — Administrators for organizations or projects are now free to
define own properties for their organizations / projects.
Example: an organization administrator can create a property named
“customer number” for his organization and the included projects. This

property can then be updated with the corresponding numbers.

Further improvements

- 28-port switches do now have their own mask for port determination within
the network.

- The LANCOM Management Cloud can now allocate multiple centralized
addresses to the branch office routers as alternative VPN endpoints.

-> Partner ID and partner status are now shown in the organization management.

- A table with all ports including their designation was added to the single
monitoring view for switches.

- The user is informed by e-mail if a device license is about to expired or has
already expired.

- When creating networks, a pre-defined color palette is now available.

Bug fixes

- Only the visible devices were filtered in the device list, and not the complete
list.

- Picture upload for organizations, projects, and devices was fixed.

-> When using the firefox browser one connection was missing in the VPN
connection table of the WAN dashboard.

- Error messages could occur when deleting a location, even though the
location was deleted successfully.

- LLDP was not always activated on the switch, although it was activated in the
project settings (LLDP monitoring requires switch firmware 3.30.0324 RU2).

- Fixed problems with the floor plan display in the safari browser.

- An issue which prevented the pairing of new devices was fixed.

- Miscellaneous internal stability improvements
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LANCOM Management Cloud 1.00.3.1.0.0 / 12.09.2017

New features

- Exclusively for LANCOM partners: As of now, all devices that are newly
integrated into the LANCOM Management Cloud get an automatic start-up
license valid for 30 days. After the 30 days have expired, a simple online /
offline status monitoring is available via dashboard and device overview.

- Exclusively for LANCOM partners: As of now, a live chat with direct access
to LANCOM Cloud experts for all questions about the LANCOM Management
Cloud is available (accessible via the menu bar).

- Floor plans of buildings can be uploaded for particular locations to place
devices exactly on these plans (“Locations > Floor plan”). For placed Wi-Fi
devices a rough coverage overview is available on the map incl. channel load
and reception quality (dashboard under “Wi-Fi / LAN” > widget “Locations
overview”).

- Device filter in the Devices overview (name, device type, serial number, IP
address, site)

- Particular location information can be filtered on the dashboard.

Further improvements
- Support for the 28-port switches in the “network” area

- Automatic e-mail notification on expiring device licenses

Bug fixes
- Issues while activating the layer 7 application detection have been fixed. For
a successful activation the configuration has to be rolled out again to the
appropriate Wi-Fi devices.
- License management issues have been fixed

- Config service issues have been fixed
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LANCOM Management Cloud 1.00.2.5.2.0 / 18.08.2017

New features

- Automatic switch port marking per LLDP

Further improvements
- The logging records if users were deleted from the organization / project.
- Devices can now be deleted directly from the LMC from within the project
(previously, there was a transfer to an organization necessary).
- The license column in the device list now shows the expiration date, and not
the remaining days.
- In the compact device view the selected tab (e.g. detail configuration) is now

stored, even if a device from another site is selected.

Bug fixes
- Fixed an issue with unconfigurable switches after claiming.
- Fixed an issue with the automatic logout, if there were unsaved changes left.
- Fixed an issue with writing configuration data to LN-630 devices.
- The current value in history graphs is now consistent (hour/day/week).
- No VPN devices were shown in the WAN dashboard under certain
circumstances.
- Fixed an issue with the dashboard widgets for Wi-Fi networks and Wi-Fi

standards.
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LANCOM Management Cloud 1.00.2.3.5.0 / 04.08.2017

New features

- As of now, the Wi-Fi optimization functions Adaptive RF Optimization and
Band Steering can be activated under “Management > Settings” (globally for
the whole project) and under “Locations > Overview > Wi-Fi Defaults” (per
location) for Access Points and WLAN routers in a project.

- From now on, a Wi-Fi SSID which is defined under “Networks > Wi-Fi > Create
new SSID”, can be activated and deactivated.

- From now on, the roaming optimization functions Opportunistic Key Caching
(OKC) and IEEE 802.11r Fast Roaming can be activated while defining a Wi-Fi
SSID under “Networks > Wi-Fi > Create new SSID".

- From now on, the SSID broadcast can be suppressed while defining a Wi-Fi
SSID under “Networks > Wi-Fi > Create new SSID”, so that the respective SSID

is no longer automatically visible for clients in the list of the available SSIDs.

Further improvements
-> Project IDs and license algorithms are now shown in the organization’s project
list.
- Single switch ports can be manually labeled in the switch monitoring.
- The current throughput is graphically shown in the switch monitoring for the
selected switch port.
- The last known port status is shown in the switch monitoring for switches with

“offline” status.

Bug fixes
- Deleting locations failed under certain circumstances
- Miscellaneous bug fixes within the switch configuration
- When rolling out configurations to a bigger amount of devices, these
configurations were partially not accepted.
- Log entries for deleted devices were showing a wildcard instead of the device
ID.

- Further general issues fixed
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LANCOM Management Cloud 1.00.170710 / 10.07.2017

Notice

For this LMC release we recommend a firmware update for switches to at least LAN-
COM Switch OS 3.30 REL (Build 3.30.0204). Without, the monitoring data will not
be accepted by the LMC anymore, due to a security check. A later update is always

possible in case the monitoring data is already missing.

New features
- When generating a new project the admin is asked if the global password

distribution should be used.

Further improvements
- The admin table can now be edited when using the individual configuration of
switches.

- The reliability of the online/offline status view has been improved.

Bug fixes

- A support problem of the devices L-321agn Wireless R2 and 730-4G has been
fixed.

- In the compact view of large projects all devices were listed but only the first
four had a configuration status displayed.

- In new projects the area location could not be entered under specific
circumstances.

- An unexpected error when deleting a location has been fixed.

- Variables were not resolved correctly for specifc log entries.
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LANCOM Management Cloud 1.00.170620 / 20.06.2017

New features
- Networks are displayed per port within the switch monitoring.
- A cloud answer time diagram was added for switches.

- A CPU load diagram was added for switches.

Further improvements
- The information area was extended by further information sources.
- The LMC can now create an offline configuration for cloud-ready devices.

- Internal improvements for tracking calls between micro services

Bug fixes

- Firmware files are now available for “(over ISDN)” and “(over POTS)" routers,
too.

- The URL which is sent to the device for upgrading the firmware is no longer
compiled wrong, so firmware updates can be done reliably.

- Sorting of the license categories is now alphabetical within the license pool.

- The VPN dashboard’s info popover shows always the selected outpost, and
not the central site.

- Changes to a site cause the status display of the central site gateway to
change to “outdated”.

- The VPN dashboard’s connection table shows again all VPN connections.

- All variables are now resolved for the log file.

- Status changes are now displayed accurately for recently added devices.

- Some user interface issues were fixed.

- Issues were fixed for the group aggregation of the dashboard monitoring data.

- Fixed an issue in the WAN dashboard’s VPN device table.
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LANCOM Management Cloud 1.00.170529 / 29.05.2017

New features
- Guided tour for organizations

- Added an info section with FAQ, hints & tricks, and tutorial videos

Further improvements

- Significantly faster loading and displaying of device detail configurations.

- License icons in the device list are gray if the project works in license mode
“NONE".

- In pairing state, the LMC public can now redirect devices to another private
cloud.

- Device-related information can now be hidden from the project log.

- If WLAN SSIDs are defined via smart config, only these are applied to the
device. There is no mix of smart config and single device configuration in this

case.

Bug fixes

- Fixed an issue where in some cases the time zone was missing when
transferring a timestamp. As a consequence, the date was misinterpreted at
the recipient.

- No more missing display of device networks and configurations due to failed
validation

- Even if DHCP is enabled, gateways with Wi-Fi feature (e.g. LANCOM
1783VAW) won't stop allocating IP addresses.

- Correct license categories are shown for LANCOM LN-17xx and LN-86x.

- Fixed an issue when transferring devices from within an organization.

- Miscellaneous internal bug fixes
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LANCOM Management Cloud 1.00.170509 / 09.05.2017

New features
- Licensing of cloud-managed LANCOM devices

- 1-click port configuration for particular switches

Further improvements

- When adding devices to sites, the first router is set as a gateway
automatically.

- The centralized device password allocation can be disabled by the project
administrator.

- Devices can be passed from the LMC public to the LMC private.

- Support for the new switch models GS-2328*

- Extended switch parameter: SNMP communities

- Improvements for the WAN dashboard

- Improved display of the Layer-7 top applications

- The WAN throughput is now shown separately for up- and downstream.

- Display for multi VPN within the WAN dashboard

- The Switch LMC operation was extended by TRY settings with “try 24h” by
default.

- Added support for LMC handover before pairing on the device.

- Device information and monitoring was merged to one single tab for better
viewing experience.

- The selection of Wi-Fi frequency bands is now possible during network

configuration.

Bug fixes

- When using the auto fill function of a Web browser, the user’s LMC login data
is no longer entered for Wi-Fi SSID and PSK in some cases.

- The CSV export of the top applications now contains the complete data.

- The timeline of the history graphs now stops moving if a device does not send
any data.

-> Fixed an issue with aggregating monitoring data.

- Corrected display of the VPN connection state within the WAN dashboard.

- Client names are now displayed similar within the Wi-Fi client table and the

top users table.
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- Fixed an issue with deleting sites.

- The window for adding devices is now displayed on the iPad, too.

-> Fixed an issue with the LMC blink mode on WLC-managed accesspoints

- Optimized DNS request count for accesspoints, routers and WLCs, and DNS
caching was added for LMC connectivity on the device.

- Automatically generated Wi-Fi PSKs now consist of 16 characters

(previously 8).
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LANCOM Management Cloud 1.00.170410 / 10.04.2017

New features
- Centralized allocation of device passwords to all devices of a project
- Display of failed login attempts for:
» Device login
* SNMP login
* WLAN SSID login

Further improvements
- Display of Internet backup connections within the single device monitoring of
routers
- Scripting feature variables can be defined as confidential and are masked on
the user interface.
- Immediate activation of new network specifications for all LANCOM devices

when changing the IP address range

Bug fixes

- An issue which prevented the configuration of the vRouter was fixed

- General text improvements

- Proper name resolution for top users

- Fixed an issue with a wrong status display within the device list after a
location rollout

-> Fixed an issue which lead to disabled networks being still active

- If multiple configuration change have been made while a device was offline, all
changes are now saved when the device is online again.

- Fixed an issue with a faulty free memory display for switches

- Fixed an issue with editing the VolP line table

- LTE routers do no longer lose their mobile connection after a configuration
rollout.

- Fixed miscellaneous issues within the single device configuration
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LANCOM Management Cloud 1.00.170316 / 16.03.2017

New features
- For sorting and filtering purposes, the device location is now shown in the
device list
- The routes which should be accessed via central site can be defined per
network
- WAN throughput is now shown in the single device monitoring

-> Access LMC using a mobile device

Further improvements
- The automatic inactivity logoff timer can be configured in the user profile
- Improvements for transmitting table contents of the device- and user list
- VPN connections are now initialized with green dotted lines on the WAN
dashboard
- Additional messages added for the account- and device log

- Further general performance improvements

Bug fixes

-> The SDN configuration is rolled out accurately to routers with activated WLC
option

- Fixed some issues which led to erroneous device status display

- Fixed the VPN connection status display on the WAN dashboard

- Messages in the account- or device log are shown accurately

- Fixed several issues in the VolP Call Router area for single device
configuration

- Further general issues fixed
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LANCOM Management Cloud 1.00.170224 |/ 24.02.2017

New features
Config test mode
- After a new configuration is uploaded, the device checks that it can still reach
the LANCOM Management Cloud. If not, the device falls back to the previous

configuration.

Simplified operation through predefined default settings:
- When you create a project, a site with the name of the project is created by
default
- When you create a project, the network “INTRANET” is created by default

E-mail integration
- When you invite previously unregistered users, an invitation e-mail with
instructions is sent automatically to their e-mail address.
- When inviting users to organizations and projects, an e-mail with an invitation

link is sent automatically to their e-mail addresses.

Password reset

- The user now has the option to reset the password, if forgotten. For this, a link

is sent to the relevant e-mail address.

Further improvements

- Immediate language switching (DE|EN) for login/registration/password reset

- The Layer-7 application detection can now be turned on and off for each SSID/
VLAN in the SDN-Configuration.

- Devices now need just one URL to connect to the LMC. All you have to enter is
the LMC domain (e.g.
cloud.lancom.de).

- LMC and LCOS now use the same policies for secure passwords.

- The gateway at a site now no longer needs to have the first address on the
corresponding network.

- The invitation link sent by e-mail is now valid for 5 days.

- A change of network IP is now displayed in the overview.

- Performance improvements

- A number of improvements have been made to the dashboard display.
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Bug fixes

- A display issue with the top Wi-Fi applications has been fixed.

- Some naming inconsistencies between the “Cloud” and “LMC” have been
fixed.

- An issue with the display of the current Wi-Fi throughput on the dashboard
has been fixed.

- The Cloud operating mode “only-without-wlc” is now available only for Wi-Fi
devices.

- An issue with setting the DNS forwarding has been fixed.

- An issue with the map zoom level on the dashboard has been fixed.
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LANCOM Management Cloud 1.00.170213 / 13.02.2017

New features
- Guided tour of the LANCOM Management Cloud
- Widgets in the Wi-Fi dashboard now optionally display the data over the last
hour, the last day or the last week.

- For sites, it is now possible to select the router that is to act as the gateway.

Security
- Users are now logged out automatically after 30 minutes (can be configured

for longer).

Improvements & bug fixes

- The overview page for a device now shows when it was incorporated into the
organization/project.

- Just one LMC domain is required for pairing and claiming. Operators of a
Private Cloud are required to ensure that the prefixes pairing.* and control.*
are available at their domain.

- Organizations and projects now have an ID.

- Performance improvements

- Individual device configurations have now been furnished with entries that
were missing so far.

- Bugs fixed in the SDN-Configuration

- Itis now no longer possible for delegated invitations to accidentally create
dead organizations and projects.

- Issues with project observers entering the areas “Networks”, “Sites” and
“Devices” have been fixed.

- Implausible entries in the Wi-Fi dashboard

- “Ghost devices” appeared in empty projects

- The WAN dashboard occasionally stops updating.

- An issue with the device and account log has been fixed.

- Arrangement of the dashboard widget is now back to normal
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4. History of incompatible API changes

LANCOM Management Cloud 1.00.178.0 / 29.10.2024
- Removed endpoints (deprecated note June 2022)
GET/POST /cloud-service-auth/accounts/{accountld}/custom-fields
GET/POST/DELETE /cloud-service-auth/accounts/{accountld}/custom-fields/
{fieldld}
GET /cloud-service-auth/custom-field-targets

GET /cloud-service-auth/custom-field-targets/{targetid}

LANCOM Management Cloud 1.00.175.0 / 20.08.2024
- Deprecated POST /cloud-service-auth/actions (ACCOUNT_DELETE and
USER_PROFILE_DELETE)
- New: POST /cloud-service-auth/user/self/delete

- New: POST /cloud-service-auth/accounts/{accountld}/delete

LANCOM Management Cloud 1.00.168.0 / 26.03.2024
- Deprecated GET /cloud-service-devices/meta/firmware?type=all

New: GET /cloud-service-devices/accounts/{accountld}/meta/firmware

LANCOM Management Cloud 1.00.160.0 / 11.10.2023
- Removed GET+PUT /cloud-service-logging/accounts/{accountld}/rules/
configuration
Existing alternative:
GET+PUT /cloud-service-logging/accounts/{accountld}/alerts/settings/

ruleconfig

LANCOM Management Cloud 1.00.157.0 / 08.08.2023
- Removed GET /cloud-service-devices/accounts/{accountld}/devices/licenses
Existing alternative:
GET /cloud-service-licenses/licenses

GET /cloud-service-licenses/licenses/ids

LANCOM Management Cloud 1.00.156.0 / 18.07.2023
- Removed GET /cloud-service-notification/accounts/{accountld}/notifications
Existing alternative: GET /cloud-service-notification/accounts/{accountld}/

alerts
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LANCOM Management Cloud 1.00.153.0 / 18.05.2023
The following APIs are deprecated and will be phased out in 3 months:
- Deprecated GET /cloud-service-devices/accounts/{accountld}/devices/
licenses
New: GET /cloud-service-licenses/licenses/ids

New: GET /cloud-service-licenses/licenses

LANCOM Management Cloud 1.00.142.0 / 27.09.2022

- Deprecated GET /cloud-service-licenses/accounts/{accountld}/
allocations?select=id
New: GET /cloud-service-licenses/accounts/{accountld}/allocations/ids

- Deprecated GET /cloud-service-licenses/licenses?select=id
New: GET /cloud-service-licenses/licenses/ids

- Deprecated GET /cloud-service-licenses/blacklist/records?select=id
New: GET /cloud-service-licenses/blacklist/records/ids

- Deprecated GET /cloud-service-licenses/accounts/{accountid}/
records?select=id
New: GET /cloud-service-licenses/accounts/{accountld}/records/ids

- Deprecated POST /cloud-service-licenses/keys?type=decrypted
New: POST /cloud-service-licenses/keys/decrypted

- Deprecated GET /cloud-service-licenses/accounts/{accountld}/
pools?select=id

New: GET /cloud-service-licenses/accounts/{accountld}/pools/ids

LANCOM Management Cloud 1.00.140.0 / 16.08.2022
The following APIs are deprecated and will be phased out in 3 months:
- Deprecated: GET /cloud-service-devices/accounts/{accountld}/devices/
{deviceld}?type=compatibles
New: /cloud-service-devices/accounts/{accountld}/devices/{deviceld}/
compatibles
- Deprecated: GET /cloud-service-devices/accounts/{accountld}/
devices?select=id
New: /cloud-service-devices/accounts/{accountld}/devices/ids
- Deprecated POST /cloud-service-devices/accounts/{accountld}/
devices?type=shadow
New: /cloud-service-devices/accounts/{accountld}/devices/preconfig
- Deprecated: PUT /cloud-service-devices/accounts/{accountld}/devices/
{deviceld}?type=preconfig
New: /cloud-service-devices//accounts/{accountld}/devices/{deviceld}/

preconfig
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- Deprecated DELETE /cloud-service-devices/devices/serial/
{serial}?type=redirected
New: /cloud-service-devices/devices/serial/{serial}/redirected

- Deprecated GET /cloud-service-devices/internal/meta/
models?type=Dblacklisted
New: /cloud-service-devices/internal/meta/models-blacklisted

- Deprecated POST /cloud-service-devices/accounts/{accountld}/
devices?type=confirm-current-firmware
New: /cloud-service-devices//accounts/{accountld}/firmware/
preferences-confirmed

- Deprecated GET /cloud-service-devices/accounts/{accountld}/sites?select=id
New: /cloud-service-devices/accounts/{accountld}/sites/ids

- Deprecated POST /cloud-service-devices/accounts/{accountld}/firmware/
preferences?content=list
New: /cloud-service-devices/accounts/{accountld}/firmware/preferences

- Deprecated GET /cloud-service-devices/accounts/{accountld}/
devices?type=table
New: /cloud-service-devices/accounts/{accountld}/devices-table

- Deprecated GET /cloud-service-devices/accounts/{accountld}/
devices?select=id&type=table
New: /cloud-service-devices/accounts/{accountld}/devices-table/ids

- Deprecated GET /cloud-service-devices/accounts/{accountld}/
devices?type=dashboard
New: /cloud-service-devices/accounts/{accountld}/devices-dashboard (only
for LMC User Interface)

- Deprecated GET /cloud-service-devices/accounts/{accountld}/
devices?type=all[1-6]
New: /cloud-service-devices/accounts/{accountld}/devices-all[1-6] (only for
LMC User Interface)

- Deprecated GET /cloud-service-devices/accounts/{accountld}/
sites?type=table
New: /cloud-service-devices/accounts/{accountld}/sites-table

- Deprecated GET /cloud-service-devices/accounts/{accountld}/sites?type=alll
New: /cloud-service-devices/accounts/{accountld}/sites-all1 (only for LMC
User Interface)

- Deprecated GET /cloud-service-devices/accounts/{accountld}/
sites?type=dashboard
New: /cloud-service-devices/accounts/{accountld}/sites-dashboard (only for
LMC User Interface)
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- Deprecated GET /cloud-service-licenses/accounts/{accountid}/
allocations?select=id
New: /cloud-service-licenses/cloud-service-licenses/accounts/{accountld}/
allocations/ids

- Deprecated GET /cloud-service-licenses/licenses?select=id
New: /cloud-service-licenses/licenses/ids

- Deprecated POST /cloud-service-licenses/keys?type=decrypted
New: /cloud-service-licenses/keys/decrypted

- Deprecated GET /cloud-service-licenses/accounts/{accountld}/
pools?select=id

New: /cloud-service-licenses/accounts/{accountld}/pools/ids

LANCOM Management Cloud 1.00.136.0 / 24.05.2022
The following APIs are deprecated and will be phased out in 6 months:

- Deprecated GET /cloud-service-auth/dpa/unaccepted

LANCOM Management Cloud 1.00.135.0 / 03.05.2022
- Filter property subnetGroupld on Endpoint GET /account/{accountld}/sites

does now accept a list of site ids

LANCOM Management Cloud 1.00.130.0 / 18.01.2022
-> Deprecation of endpoint GET /cloud-service-devices/accounts/{accountld}/
devices?type=table
- Deprecation of endpoint GET /cloud-service-devices/accounts/{accountld}/

devices?select=id&type=table

LANCOM Management Cloud 1.00.128.0 / 07.12.2021
- Deprecated GET/POST /cloud-service-auth/accounts/{accountld}/
custom-fields
- Deprecated GET/POST/DELETE /cloud-service-auth/accounts/{accountld}/
custom-fields/{fieldld}
- Deprecated GET /cloud-service-auth/custom-field-targets

- Deprecated GET /cloud-service-auth/custom-field-targets/{targetid}
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LANCOM Management Cloud 1.00.123.0 / 24.08.2021
The following APIs are deprecated and will be phased out in 6 months (end of
February 2022):
- Deprecated GET /accounts/{accountld}/alerts/settings
- Deprecated PUT /accounts/{accountld}/alerts/settings
- Deprecated GET /accounts/{accountld}/notifications/rules/settings
- Deprecated PUT /accounts/{accountld}/notifications/rules/settings
- Deprecated GET /accounts/{accountld}/notifications/settings
- Deprecated POST /accounts/{accountld}/notifications/settings
- Changed GET /accounts/{accountld}/metrics/alerts/device/{deviceld}/value
- Changed GET /accounts/{accountld}/metrics/configurations

- Changed POST /accounts/{accountld}/metrics/configurations

LANCOM Management Cloud 1.00.118.0 / 11.05.2021

- Changed GET /cloud-service-monitoring/accounts/{accountld}/processing

LANCOM Management Cloud 1.00.115.0 / 09.03.2021
- Deprecated GET /users

LANCOM Management Cloud 1.00.113.0 / 25.01.2021
- Changed GET /accounts/{accountld}/firmware/update
- Changed POST /accounts/{accountld}/firmware/update
- Changed PUT /accounts/{accountld}/condition
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5. General advice

Disclaimer

LANCOM Systems GmbH does not take any guarantee and liability for software not
developed, manufactured or distributed by LANCOM Systems GmbH, especially not

for shareware and other extraneous software.

LANCOM Systems GmbH

A Rohde & Schwarz Company
Adenauerstr. 20/B2

52146 Wuerselen | Germany

info@lancom.de | lancom-systems.com

LANCOM, LANCOM Systems, LCOS, LANcommunity and Hyper
Integration are registered trademarks. All other names or
descriptions used may be trademarks or registered trademarks of
their owners. This document contains statements relating to future
products and their attributes. LANCOM Systems reserves the right
to change these without notice. No liability for technical errors
and / or omissions. 12/2024
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